COMPENDIUM OF PROCEDURES:
TÈCNIQUES EXPERIMENTALS
EN AEROFÍSICA (TEA)

Authors: Jose I. Rojas & Xavier Prats

Laboratori de la titulació
d’Enginyeria Aeronàutica Tècnica

Escola d’Enginyeria de Telecomunicació i Aeronàutica de Castelldefels (EETAC)
Universitat Politècnica de Catalunya (UPC BarcelonaTech)
2007-2011
PROJECT FACULTY AND TEACHING ASSOCIATE

Santiago Arias Calderón
Daniel Crespo Arriaga
Pilar Gil
Jordi J. Gutiérrez
David Pino
Xavier Prats Menéndez
José I. Rojas Gregorio
Adeline de Villardi de Montlaur
## Table of Contents

1 INTRODUCTION .................................................................................................................. 1

2 HARDNESS TESTS .......................................................................................................... 2

2.1 MEETINGS PRIOR TO THE ACTIVITY ....................................................................... 2

2.1.1 Meeting with CTM teacher .................................................................................. 2

2.1.2 TEA coordinator .................................................................................................. 2

2.1.3 Aerospace trainees ............................................................................................... 3

2.2 PREPARATION OF THE ACTIVITY ......................................................................... 3

2.2.1 Preparing the activity ........................................................................................ 3

2.2.2 Activity procedure ............................................................................................. 5

2.2.3 Activity debriefing ............................................................................................ 6

3 MODEL ROCKET WORKSHOP ....................................................................................... 9

3.1 PREPARATION OF THE MODEL ROCKET WORKSHOP ........................................ 9

3.1.1 Generic pieces acquisition ................................................................................ 9

3.1.2 Model rocket pieces acquisition ....................................................................... 9

3.1.3 Altimeter acquisition or construction ............................................................. 13

3.2 KICK-OFF SESSION ................................................................................................. 13

3.2.1 Characteristics of kick-off session .................................................................... 14

3.2.2 Preparation of kick-off session ......................................................................... 14

3.2.3 Activity procedure ........................................................................................... 14

3.2.4 Team structure delivery ................................................................................... 15

3.3 ROLES (EXPERT ENGINEERS) ................................................................................ 15

3.4 MISSION ANALYSIS .................................................................................................. 16

3.4.1 Preliminary trajectory simulations .................................................................... 16

3.4.2 Preliminary simulations delivery ....................................................................... 16

3.4.3 Preliminary simulations crosscheck .................................................................. 16

3.4.4 Mission engineers meeting .............................................................................. 16

3.4.5 Accurate (final) trajectory simulations ............................................................ 17

3.4.6 Accurate (final) simulations delivery ............................................................... 17

3.5 ROCKET DEVELOPMENT ............................................................................................ 17

3.5.1 Design and construction operations .................................................................. 17

3.5.2 Design and construction operations delivery .................................................. 17

3.5.3 Rocket construction .......................................................................................... 17

3.5.4 Progress construction document delivery ....................................................... 19

3.5.5 Technical specifications sheet .......................................................................... 19

3.5.6 Technical specifications sheet delivery ............................................................. 19

3.6 ROCKET CERTIFICATION PROCESS ................................................................... 19

3.6.1 Preliminary test procedures design .................................................................. 19

3.6.2 Preliminary test procedures delivery ................................................................. 19

3.6.3 Test engineers meeting .................................................................................... 19

3.6.4 Harmonised test procedures delivery .............................................................. 20

3.6.5 Harmonised test procedures amendments ..................................................... 20

3.6.6 Harmonised test procedures review ................................................................ 20

3.6.7 Harmonised test procedures approval ............................................................. 20

3.6.8 Rocket certification session ............................................................................. 21

3.7 LAUNCH OPERATIONS ............................................................................................... 22

3.7.1 Preliminary launch procedures design ............................................................. 22

3.7.2 Preliminary launch procedures delivery ............................................................ 23

3.7.3 Launch engineers meeting ............................................................................... 23

3.7.4 Harmonised launch procedures delivery ......................................................... 23

3.7.5 Harmonised launch procedures amendments ............................................... 23

3.7.6 Harmonised launch procedures review ............................................................ 23

3.7.7 Harmonised launch procedures approval ....................................................... 24
3.7.8 Launching campaign ................................................................. 24
3.8 RECOVERY OF ALTIMETER DATA ...................................... 24
3.9 FLIGHT DATA PROCESSING AND FINAL REPORT .............. 25
3.10 FINAL PRESENTATION: THE PRESS CONFERENCE SESSION  26
   3.10.1 Characteristics of the press conference session .................. 26
   3.10.2 Preparation of the press conference session ..................... 26
   3.10.3 Remarks on the final presentation .................................... 26
   3.10.4 Activity procedure .......................................................... 26
3.11 FUTURE WORK .................................................................... 27
3.12 DETECTED DEFECTS DURING THE COURSE OF MRW .......... 27

4 SATELLITE TOOL KIT (STK) WORKSHOP ................................. 28
4.1 Exercise 1: Learning the basis .................................................... 28
   4.1.1 Exercise preparation ......................................................... 28
   4.1.2 Briefing ........................................................................... 29
   4.1.3 Procedure: Definition of the scenario ............................... 29
   4.1.4 Questions ....................................................................... 31
   4.1.5 Conclusions .................................................................... 33
4.2 Exercise 2: Tracking antenna in a ground station ..................... 33
   4.2.1 Exercise preparation ......................................................... 33
   4.2.2 Briefing ........................................................................... 34
   4.2.3 Procedure: Definition of the scenario ............................... 34
   4.2.4 Questions ....................................................................... 35
   4.2.5 Conclusions .................................................................... 36
4.3 Exercise 3: Types of orbits ....................................................... 36
   4.3.1 Exercise preparation ......................................................... 36
   4.3.2 Briefing ........................................................................... 37
   4.3.3 Procedure: Definition of the scenario ............................... 37
   4.3.4 Questions ....................................................................... 37
   4.3.5 Conclusions .................................................................... 39
4.4 Exercise 4: Mission analysis ..................................................... 39
   4.4.1 Exercise preparation ......................................................... 39
   4.4.2 Briefing ........................................................................... 39
   4.4.3 Procedure: Definition of the scenarios ............................ 40
   4.4.4 Questions ....................................................................... 40
4.5 Exercise 5: ............................................................................. 40
4.6 STK academic alliance program ............................................. 40
4.7 General comments ................................................................... 40

5 UTM TESTS ............................................................................. 42
5.1 Preparation of the hands-on activity ....................................... 42
5.2 Activity procedure ................................................................. 42

6 WIND TUNNEL TESTS ............................................................... 44
6.1 PROBLEMS TO BE SOLVED .............................................. 44
   6.1.1 Problem 01: Unidentified connection tubes ..................... 44
   6.1.2 Problem 02: Clamp is loosen ......................................... 44
6.2 TESTS ON CYLINDER ......................................................... 44
   6.2.1 Preparation of hands-on activity ................................. 44
6.3 TESTS ON NACA0012 AIRFOIL ........................................ 45
   6.3.1 Preparation of hands-on activity ................................. 45
   6.3.2 Activity procedure ......................................................... 45

7 ANNEX A .............................................................................. 48
8 ANNEX B .............................................................................. 52
9 ANNEX C .............................................................................. 56
10 ANNEX D ............................................................................ 58
11 ANNEX E ............................................................................ 59
12 ANNEX F .......................................................................................................................................... 61
13 ANNEX G ...................................................................................................................................... 65
# List of Acronyms and abbreviations

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT</td>
<td>Aerospace Trainee</td>
</tr>
<tr>
<td>B</td>
<td></td>
</tr>
<tr>
<td>CSBI</td>
<td>Castefa Space and Beyond Inc.</td>
</tr>
<tr>
<td>CTM</td>
<td>Materials Science and Technology (Subject)</td>
</tr>
<tr>
<td>DE</td>
<td>Development Engineer</td>
</tr>
<tr>
<td>EE</td>
<td>Expert Engineers</td>
</tr>
<tr>
<td>EETAC</td>
<td>Escola d’Enginyeria de Telecomunicació i Aeronàutica de Castelldefels</td>
</tr>
<tr>
<td>EO</td>
<td>Earth Observation</td>
</tr>
<tr>
<td>FOV</td>
<td>Field of View</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>GEO</td>
<td>Geostationary Earth Orbit</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>h</td>
<td>hour(s)</td>
</tr>
<tr>
<td>HB</td>
<td>Hardness Brinell</td>
</tr>
<tr>
<td>HEO</td>
<td>Highly Elliptical Orbit</td>
</tr>
<tr>
<td>HR</td>
<td>Hardness Rockwell</td>
</tr>
<tr>
<td>HHRR</td>
<td>Human Resources</td>
</tr>
<tr>
<td>HT</td>
<td>Hardness Tester</td>
</tr>
<tr>
<td>ISS</td>
<td>International Space Station</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td></td>
</tr>
<tr>
<td>kg-f</td>
<td>Kilogram-force</td>
</tr>
<tr>
<td>kp</td>
<td>Kilopond</td>
</tr>
<tr>
<td>LAE</td>
<td>Launch Engineer</td>
</tr>
<tr>
<td>LEO</td>
<td>Low Earth Orbit</td>
</tr>
<tr>
<td>LOE</td>
<td>Logistics Engineer</td>
</tr>
<tr>
<td>M</td>
<td>Mission Engineer</td>
</tr>
<tr>
<td>MEO</td>
<td>Medium Earth Orbit</td>
</tr>
<tr>
<td>MRW</td>
<td>Model Rocket Workshop</td>
</tr>
</tbody>
</table>

| N   | N |
| R   | R |

| S   | Spacecraft |
| S/C | Statement of Work |
| SSO | Sun Synchronous Orbit |
| STK | Satellite Tool Kit |

| T   | Aerospace Technology (Subject) |
| TAE | Test Engineer |
| TEA | Experimental Techniques in Aerophysics (Subject) |
| TS  | Tensile Stress |
| TTC | Telemetry, Tracking and Command |

| U   | Ultimate Tensile Stress |
| UTS | Universal Testing Machine |

| V   | V |

| W   | Wind Tuning or Wind Tunnel |
Introduction

This document is a compendium of procedures for conducting several hands-on activities at Escola d'Enginyeria de Telecomunicació i Aeronàutica de Castelldefels (EETAC). It is thought to be a helpful tool for the educational staff (i.e. teachers assisted by aerospace trainees) in the preparation, managing and in situ realization of the considered activities.

Therefore, the main objectives of the document are:

- To ease and optimize all the phases of the activities, acting as a support, quick-consultation guide
- To reduce the time consumption (duration) of the activity organization process
- To guarantee the repeatability of the activities regardless who is in charge of them
- To allow and facilitate the teachers to delegate tasks on aerospace trainees
Chapter 1
Hardness Tests

Through the realization of this hands-on activity the students will learn the basis of the functioning and operation of a Hardness Tester (HT). To achieve this objective the students will perform hardness tests on several samples. The students will also recall the theoretical knowledge on materials’ hardness that they acquired in the frame of the subject so-called Materials Science and Technology (CTM).

2.1 MEETINGS PRIOR TO THE ACTIVITY

It is strongly recommended to ask the following persons for advice prior to the realization of the activity. After the activity, feedback should be given to them too, so as to improve it.

2.1.1 Meeting with CTM teacher

One should contact the Ciència i Tecnologia de Materials (CTM) teacher in order to get suggestions and feedback. Here follow some comments from the teacher.

CTM subject

In principle, no extensive, high-educational-value exercise can be prepared referred to hardness and using hardness data (except from what already proposed in Section Error! Reference source not found.). In CTM, hardness is presented briefly.

Suggestions from CTM teacher (Santiago Arias, QT07-08)

- Try comparing the hardness of two identical samples except from the fact that one has been annealed (e.g. Al and annealed$^1$ Al)
- Make students search the reasons for hardening

Feedback from CTM teacher

- …

2.1.2 TEA coordinator

One should contact the Tècniques Experimentals en Aerofísica (TEA) coordinator in order to get suggestions and feedback. Here follow some comments from the teacher.

Suggestions from TEA coordinator (Daniel Crespo, QT07-08)

- Try testing samples of different materials. E.g. buy 2 or more samples of the following materials: Fe (iron), Cu (cupper), Al (aluminium), brass, Teflon, Methacrylate, wood, ceramics…
- Propose the students to calculate the hardness by mathematical expressions given in references {{297 Callister,William D. 1985}}

$^1$ Annealing of samples can be done in GCM's furnace located in laboratory SA-3B (contact Daniel Crespo or Pere Bruna to get authorization to use the furnace and help on how to use it).
Feedback from TEA coordinator

- …

2.1.3 Aerospace trainees

One should contact the aerospace trainee (AT) and meet him to start the preparation of the hardness tests. The coordinator of TEA should ask EETAC Management well in advance (the deadline is usually around mid July) for an AT to help preparing this and other hands-on activities. Ideally, the trainee would be in charge of the overall preparation of the hands-on activity (see Section 2.2) and accomplishing certain tasks prior to and during it, so the teacher is relieved of a major part of the work. E.g. David Díaz’s TFC Section 4.2 (page 32) and David Díaz’s TFC Report Annex B (page 58) can be used as guides for this activity, too.

Suggestions from AT (XXXX, QT07-08)

- …

Feedback from AT

- …

2.2 PREPARATION OF THE ACTIVITY

- Upload in Atenea-Moodle TEA course the following documents:
  - Manual_Durometro_Metrotec.pdf
  - Pag_Manual_Durometro_Metrotec_01.pdf
  - Pag_Manual_Durometro_Metrotec_02.pdf
  - TEA_HardnessTests_SoW.pdf
- Students should print and read several parts of the first file and the entire second, third and fourth files, prior to the realization of the activity
- Find in Table 2.1 the message to be posted in Atenea-Moodle TEA course
- In case students have not printed the documents, prepare several sets (e.g. as many as teams) of photocopies of the following:
  - Pag_Manual_Durometro_Metrotec_01.pdf
  - Pag_Manual_Durometro_Metrotec_02.pdf
  - Manual_Durometro_Metrotec.pdf: page 20 to 27 (sections 9.2. to 9.6.), 34 to 36 (sections 10.1.8. to 10.2.) and 45 to 51 (section 11.)
- Prepare samples:
  - Check if there are available samples. Otherwise, buy (or replace) materials: e.g. Al rods (bars) around 20 cm long per 2 cm in diameter, Fe, Cu, brass, Teflon, Methacrylate, wood laminas or rods… in stores
  - Process row materials if necessary: e.g. cut Al rods into 1 cm long, 2 cm in diameter cylinders by means of machining
  - Annealing of some samples: heat some samples up to certain temperatures for certain periods of time (you can anneal Al samples using temperature-time settings used for samples prepared for previous sessions)

---

2 This task can only be done by TEA teachers, who have editing privileges for TEA course.
3 You can find an example of the statement of work (SoW) in Annex A.
4 This task can only be done by TEA teachers, who have editing privileges for TEA course.
5 There should be some copies already available in the SA-1V laboratory closet 06.
6 There should be some samples already available in the SA-1V laboratory closet 06.
7 E.g. Servei Estació (Barcelona: C/ Aragó 270-272) or Bauhaus (Barcelona, Castelldefels…).
8 For machining, contact Serveis Tècnics or Maintenance/Laboratory Staff.
9 Annealing of samples can be done in GCM’s furnace located in laboratory SA-3B (contact Daniel Crespo or Pere Bruna to get authorization to use the furnace and help on how to use it).
Depending on the samples, the settings of the HT have to be changed to a new configuration (e.g. HRH tests for Al samples). The default test is the HRC test, and any time the HT is switched off, the settings are reset. Thus it is recommended to train changing the settings in advance so to be able to do it faster during the hands-on activity. Afterwards, it takes only around 2-5 min to change the settings during the realization of the activity. In the particular case of Al samples, the settings we often use are:

- Rockwell test HRH
- Time of application of the load: 10 s
- Tolerance settings are set as default. Maximum tolerance might be changed in case it is desired to reject anomalous tests
- Stabilization factor: 6
- Correction factor:
- For Rockwell test HRH -F, set corrections due to cylinder mode

Table 2.1 Activity presentation message

<table>
<thead>
<tr>
<th>Activity presentation message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardness measurements with hardness tester:</td>
</tr>
<tr>
<td>Through the realization of this hands-on activity the students will learn the basis of the functioning and operation of a Hardness Tester (HT). To achieve this objective the students will perform hardness tests on several samples. The students will also recall the theoretical knowledge on materials’ hardness that they acquired in the frame of the subject so-called Materials Science and Technology (CTM).</td>
</tr>
<tr>
<td>Here you can find the following files:</td>
</tr>
<tr>
<td>1.- The hardness tester users guide. The most interesting parts for the realization of the activity are already included in the files below (files 2 and 3). Nevertheless, other important parts are those ranging from page 20 to 27 (sections 9.2. to 9.6.), 34 to 36 (sections 10.1.8. to 10.2.) and 45 to 51 (section 11.). Read them carefully.</td>
</tr>
<tr>
<td>Manual_Durometro_Metrotec.pdf</td>
</tr>
<tr>
<td>2.- Each group should read and bring to class a copy of the pdf file:</td>
</tr>
<tr>
<td>Pag_Manual_Durometro_Metrotec_01.pdf</td>
</tr>
<tr>
<td>3.- Each group should read and bring to class a copy of the pdf file:</td>
</tr>
<tr>
<td>Pag_Manual_Durometro_Metrotec_02.pdf</td>
</tr>
<tr>
<td>4.- Each group should read and bring to class a copy of the pdf file:</td>
</tr>
<tr>
<td>TEA_HardnessTests_SoW.pdf</td>
</tr>
<tr>
<td>The deadline for delivering the report on the hands-on activity is the 22nd of December 2009.</td>
</tr>
<tr>
<td>The following is a very interesting reference that you can find in the Campus Library:</td>
</tr>
<tr>
<td>Title: Materials science and engineering: an introduction</td>
</tr>
<tr>
<td>Authors: Callister, William D.</td>
</tr>
<tr>
<td>Source: 1985, 602, John Wiley, New York etc.</td>
</tr>
</tbody>
</table>
2.3 ACTIVITY PROCEDURE

- **Explanations about Materials Science and Technology:**
  - **Description of Stress vs. Strain plot:**
    - Definition of Stiffness and Hooke’s Law
    - Definition of Yield Stress
    - Definition of UTS
  - **Hardness:**
    - Definition of hardness: reluctance to local plastic deformation
    - Utility: easy to measure and provides UTS information
    - Mechanism of plastic deformation in metals: the most important is the slip of dislocations (type of linear defects)
    - Strengthening mechanisms: reduce movement of dislocations:
      - By causing plastic deformation: increase dislocation density
      - Precipitation treatments: addition of alloying species and realization of heat-treatments to tailor the microstructure of the alloy. Through adequate treatments (e.g. T vs. time profiles) the following can be fine tuned:
        - Microstructure: grain boundary length, grain size, distribution (type, size and density) of precipitates
        - Mechanical properties: UTS, hardness, corrosion and crack propagation behaviour and ductility
  - **Explain the types of hardness tests:**
    - Hardness Rockwell (HR): related to depth of penetration
    - Hardness Brinell (HB): related to the diameter of the print
    - Hardness Vickers (HV):
  - **Explain why it is necessary to load the sample with the pre-load:**
    - Eliminate error due to surface defects
  - **Explain why it is necessary to measure far from edges and other footprints:**
    - Hardness might be locally larger there because of higher density of defects or strengthening by plastic deformation

- The students should split into groups (e.g. 4 groups or MRW groups)
- **Test selection quiz:** Students have to select the most suited test for each of the following materials (check Table 1 in section 11. of the HT users guide, page 45):
  - Fe: HRB
  - Cu: HRF or G
  - Al: HRH 1/8” 10-60 kg-f
  - Brass: HRK -L -M -P -R or -S
  - Teflon: HRK -L -M -P -R or -S (synthetic materials)
  - Methacrylate: HRK -L -M -P -R or -S (synthetic materials)
  - Laminated Wood: HRK L M P R o S
  - Ceramics: …

- In the meanwhile, the teacher/trainee should set the HT settings to desired values
- The teacher/trainee should perform 2-3 tests in one sample to show the students how to operate the HT (e.g. HRH test in Al samples as-received)
- Each group performs one test and the iterative sequence starts again (do as many tests as possible to improve statistical validation of results)
- It is important to remind that existing defects in the samples may cause errors in the first hardness measurements, so the first results may have to be rejected
- If possible, note down penetration depth \( h \) (or \( t \)) as it appears in the display of the HT or after measuring it
• If possible, calculate Rockwell hardness with formulae in HT users guide \{297 Callister, William D. 1985\}, where penetration depth $b$ is the input, and compare the results with the readings provided by the HT

• Convert Rockwell hardness readings into Brinell hardness using tables in HT users guide or in:
  - http://www.metal-mart.com/Guides/Hardness_Aluminum.htm

• If possible, perform Brinell hardness tests (it is not possible to perform Brinell hardness tests but to calculate Brinell hardness using the HT software)

• Check that the calculated conversion results are the same as those obtained through the Brinell hardness tests

• Calculate sample’s Ultimate Tensile Stress (UTS) using Brinell hardness data and empirical formulae \{297 Callister, William D. 1985\}

• Explain the differences in the hardness readings for the annealed (heat-treated) aluminium samples and the ones for the as-received, non-annealed samples

• Explain the effects of the annealing profile shape (temperature vs. time parameters of the heat treatment) on the hardness of the samples

• Explain the reasons for the differences in the hardness readings and the effects of the annealing profile shape

• Should several materials have been tested, compare the hardness results, put them in order form higher strength to lower strength (check that experimental results agree with what expected according to theory) and justify why these materials have different hardness

• Real values of hardness of different aluminium alloys can be found in literature: HRB and HB5 for AA 7075-T6 \{230 Clark, R. 2005; 227 Reda, Y. 2008\}, HV micro-hardness and Knoop hardness for AA 7000 \{249 Ferragut, R. 1996; 300 Lyman, C.E. 1976; 250 Yannacopoulos, S. 1994\}, HV micro-hardness for 2024-T3 and 7075-T6 \{229 Shaw, W.J.D. 1999\}, HRB for AA 2000 and 2024 \{232 Shih, H.C. 1996\}. Some examples of Rockwell and Brinell hardness of aluminium alloys are the following\(^{10}\):
  - AA 2011-T3: HRB 60, HB 95
  - AA 2024-T3: HRB 75, HB 120
  - AA 5052-H32: HB 60
  - AA 6061-T6: HRB 60, HB 95
  - AA 6063-T52: HB 60
  - AA 6262-T6511: HB 71
  - AA 7075-T6: HRB 87, HB 150

• Explain why we use HRB for these AA while we use HRH for our aluminium

### 2.4 ACTIVITY DEBRIEFING

In Table 2.2 and present examples of the activity debriefing messages to be posted in Atenea-Moodle TEA course after the realization of the hands-on activity.

\(^{10}\) This information was found in: http://www.onlinemetals.com/aluminumguide.cfm
**Table 2.2** Example of activity debriefing message (2007).

<table>
<thead>
<tr>
<th>Hardness tests series:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardness tester model: 713-SRD</td>
</tr>
<tr>
<td>Test type: Hardness Rockwell HRH 60 kg-f (kp)</td>
</tr>
<tr>
<td>Pre-load: 10 kg-f (kp)</td>
</tr>
<tr>
<td>Indentator: (steel sphere) HRH ball 1/8 &quot;</td>
</tr>
<tr>
<td>Sample: aluminium cylindrical-shape (20 mm-diameter, 10 mm-length) sample</td>
</tr>
<tr>
<td>Date: 18:00 h, 2007-11-28</td>
</tr>
<tr>
<td>Environmental conditions: T 19ºC</td>
</tr>
<tr>
<td>Prepared by: XXXX</td>
</tr>
<tr>
<td>Supervised by: YYYY</td>
</tr>
</tbody>
</table>

Measurements on as-received material:
74.5
75.4

Measurements for sample X (heated up to 200ºC for 4h):
76.6
77.7

Measurements on sample Y (heated up to 300ºC for 4h, but failed annealing):
73.7
73.8
73.2

Measurements on sample Z (heated up to 450ºC for 4h):
76.4
74.8
74.7

Measurements on sample W (heated up to 300ºC for 4h):
76.3
75.2
75.1

Try conversion of Hardness Rockwell measurements to Hardness Brinell (see ref.).
Try obtaining the Ultimate Tensile Stress from Hardness Brinell results (see ref.).
**Table 2.3** Example of activity debriefing message (2009).

<table>
<thead>
<tr>
<th>Hardness tests series:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardness tester model: 713-SRD</td>
</tr>
<tr>
<td>Test type: Hardness Rockwell HRH 60 kg-f (kp)</td>
</tr>
<tr>
<td>Pre-load: 10 kg-f (kp)</td>
</tr>
<tr>
<td>Indentator: (steel sphere) HRH ball 1/8 &quot;</td>
</tr>
<tr>
<td>Sample: aluminium cylindrical-shape (20 mm-diameter, 10 mm-length) sample</td>
</tr>
<tr>
<td>Date: 18:00 h, 2007-11-28</td>
</tr>
<tr>
<td>Environmental conditions: T 19°C</td>
</tr>
<tr>
<td>Prepared by: XXXX</td>
</tr>
<tr>
<td>Supervised by: YYYY</td>
</tr>
</tbody>
</table>

Measurements on as-received material:

- Measurements on sample X (heated up to 200°C for 1h):
- Measurements on sample X (heated up to 200°C for 4h):
- Measurements on sample Y (heated up to 300°C for 1h):
- Measurements on sample Y (heated up to 300°C for 4h):
- Measurements on sample Z (heated up to 450°C for 1h):
- Measurements on sample Z (heated up to 450°C for 4h):

Try conversion of Hardness Rockwell measurements to Hardness Brinell (see ref.). Try obtaining the Ultimate Tensile Stress from Hardness Brinell results (see ref.).
Chapter 2

Model Rocket Workshop

3.1 PREPARATION OF THE MODEL ROCKET WORKSHOP

3.1.1 Generic pieces acquisition

- At the end of one workshop or (at least) a month in advance to the coming workshop, the Aerospace Trainee (AT) should inventory the remaining material and equipment after the previous season.
- The AT should also identify the missing and consumed equipment, the material needs for the next course, and purchase (see section 3.1.2) according to this analysis.
- Ancillary material can be acquired in several places:
  - **InterSport Quinze**: Address: Centro Comercial Barnasud, Calle Progrés, 69 – 08850 – Gavà
    Phone: 0034 93 633 34 34
    Email: quinze@shop.intersport.es
    Timetable: Monday to Saturday from 10.00h – 22.00h
  - **InterSport MontiSport Gala**: Address: Carrer Bonavista, 18 – 08012 – Barcelona
    Phone: 0034 93 218 37 32
    Email: montisport@shop.intersport.es
    Timetable: Monday to Saturday from 10.00h – 22.00h
  - **Servei Estació**: Barcelona C/ Aragó 270-272
  - **Bauhaus**: Barcelona Castelldefels: Ànec Blau

3.1.2 Model rocket pieces acquisition

The supplier of model rocket pieces is Noris-Raketen, placed in Germany. In the following, the contact details and 4 examples of order emails are shown (Table 3.2).

---

11 Thermal blanket for parachutes can be bought here.
12 Many other model rocket components suppliers can be found on-line.
Table 3.3, Table 3.4 and Table 3.5). The rocket components are consumables and have to be purchased every course, or alternatively, a bigger order can be issued that accounts for equipment for several courses. In the latter case, the shipping expenses are minimized but expiring dates of rocket engines should be taken into account. Universities and other institutions are granted with discounts.

Anyway, it is strongly recommended that the first contact with Noris-Raketen aiming to acquire the pieces be established at least a month in advance to the first construction session of the workshop, to ensure that the pieces will arrive on time for that session. For instance, shipping time is one week for other European countries than Germany.

Table 3.1 Contact details of Noris-Raketen.

<table>
<thead>
<tr>
<th>Contact details of Noris-Raketen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daniela and Kurt Rehberger:</td>
</tr>
<tr>
<td><a href="mailto:rehberger.kurt@gmx.de">rehberger.kurt@gmx.de</a></td>
</tr>
<tr>
<td><a href="mailto:info@noris-raketen.de">info@noris-raketen.de</a></td>
</tr>
<tr>
<td>Tel.: +49 09181 32 00 58</td>
</tr>
<tr>
<td>Fax.: +49 09181 32 09 71</td>
</tr>
</tbody>
</table>

Table 3.2 Example #1 of order email.

At the Technical University of Catalonia (UPC) we are preparing an experimental exercise regarding rocketry and launchers for Aerospace Engineers. A major part of the experimental set up will consist in the design, construction and launching of several model rockets. For this reason we have visited your web page and we have found that the necessary components would be the following ones:

- Launching ramp 1 unit
  Startrampe
  Best. -Nr. 140
  Preis: 20,50 EUR

- Ignitor 1 unit
  All-Zweck-Raketenmodell-Anzündgerät RO-X
  Best.-Nr. 065
  Preis: 35,00 EUR

- Motors 9 units
  Motortyp D7-3
  Best.-Nr. 333

- Nose fairing 7 units
  Raketenspitzen
  Best.-Nr. 077
  Preis: 6,70 EUR

- Cylinders 7 units
  Raketenrohre
  Best.-Nr 069
  Preis: 5,00 EUR

Please do not hesitate to suggest us any other components that would be of interest for the development of the practical exercise. Due to administrative reasons before we can proceed to the acquisition of these products, it is mandatory for us to receive a proforma invoice from your company. Would it be possible for you to send us such a proforma invoice urgently? Thank you for your cooperation.
Table 3.3 Example #2 of order email.

- Motors  we want 2 boxes (6 motors in total)
  Motortyp D7-0
  Best.-Nr. 000
- Nose fairing  6 units
  Raketenspitzen
  Best.-Nr. 077
- Cylinders  6 units
  Raketenrohre
  Best.-Nr 069
- Treibsatzhalterungen  6 units
  Best.-Nr 321

Table 3.4 Example #3 of order email.

As every semester since February 2006, we now begin again a rocketry subject at our university and I am writing to you to order the material. We need for the rocket construction (4 rockets in total).

This is the list of equipment we need:

1.- Motors: 2 boxes (6 motors in total)
   Motortyp D7-0
   Best.-Nr. 000

2.- Nose fairing (Raketenspitzen): 5 units
   Best.-Nr. 077

3.- Cylinders (Raketenrohre): 5 units
   Best.-Nr 069

4.- Engine bracket (Treibsatzhalterungen): 5 units
   Best.-Nr 321

5.- Fuselage-nose fairing joint/adapter (Hohlverbinder): 5 units
   Best.-Nr 328

6.- Fire-proof cotton (Schutzwatte): 5 units

Please, do not hesitate to suggest us any other components that would be of interest for the development of the practical exercise (we already have parachutes, igniter, etc.).

Due to administrative reasons, before we can proceed to the acquisition of these products, it is mandatory for us to receive a proforma invoice from you. You can send it to us as a pdf, giff, jpg ... file. When I receive the invoice, I will do the bank transfer. We need the material here in Barcelona around the 31st of October.

We look forward to receive your answer.
Table 3.5 Example #4 of order email.

I.- The first is for the subject about rockets:

We need material for the construction of 4 rockets (plus some material in excess in case something is broken during construction):

1.- Motors: 2 boxes (6 motors in total) Motortyp D7-0
   Best.-Nr. 000
2.- Nose fairing\(^\text{13}\) (Raketenspitzen): 5 units (*)
   Best.-Nr. 077
3.- Cylinders (Raketenrohre): 5 units
   Best.-Nr 069
4.- Engine bracket (Treibsatzhalterungen): 5 units
   Best.-Nr 321
5.- Fuselage-nose fairing joint\(^\text{13}\) (Hohlverbinder): 6 units
   Best.-Nr 328
6.- Fire-proof cotton (Schutzwatte): 2 units

II.- The second order is the material to build 1 rocket (plus some material in excess in case something is broken during construction) to be launched the 9th of October during the celebration of the 10\(^\text{th}\) Anniversary of Ariane Rockets:

1.- Motors: 1 box (3 motors in total) Motortyp D7-3
2.- Nose fairing\(^\text{13}\) (Raketenspitzen): 1 unit (*)
   Best.-Nr. 077
3.- Cylinders (Raketenrohre): 2 units
   Best.-Nr 069
4.- Engine bracket (Treibsatzhalterungen): 2 units
   Best.-Nr 321
5.- Fuselage-nose fairing joint\(^\text{13}\) (Hohlverbinder): 2 units (**)
6.- Fire-proof cotton (Schutzwatte): 1 unit

Please, do not hesitate to suggest us any other components that would be of interest for the development of the practical exercise (we already have parachutes, ignitor, etc.).

\(^(*)\) I think last year we had problems with this item, since it was no longer produced. Please feel free to change this Nose fairing and select another model with a diameter of 60 mm. The ones we prefer are the sharp 175 mm long, instead of the 95 mm long (see Fig. 1).

\(^(**)\) I remember from other orders that depending on the type of fuselage or nose fairing this component might not be necessary.

We would appreciate you send us 2 separate invoices (for order I and for order II). Once I receive the invoices, I will do the bank transfers. We need the material here in Barcelona around the 31st of October.

For the order I, the deadline (the day we need the pieces here) is quite far (5th of November). But for the order II, the deadline is quite demanding. We need the pieces here before the 9th of October (for instance, the 1st of October would be perfect) so we be very grateful if you could process this order faster.

\(^{13}\) Since year 2007, Noris-Raketen provides only one type of nose fairing (raketenspitzen) with a 60mm diameter. This nose fairing is available in stock and it doesn’t need the fuselage-nose fairing joint (hohlverbinder).
3.1.3 Altimeter acquisition or construction

The supplier of the altimeters is PerfectFlite (Perfect Flight) Electronics. The acquired altimeter model was the PerfectFlite MiniAlt. PerfectFlite Electronics provides a wide range of rocketry electronic components: altimeters, timers and acceleration switches. In can find the contact details (see Table 3.6). The altimeters are reusable and can be utilized repeatedly in several courses, provided they are carefully used and stored in adequate conditions.

Anyway, it is strongly recommended that the first contact with PerfectFlite Electronics aiming to acquire the altimeters be established at least a month in advance to the first construction session of the workshop, to ensure that the altimeters will arrive on time for that session.

Table 3.6 Contact details of PerfectFlite Electronics.

<table>
<thead>
<tr>
<th>PerfectFlite Electronics:</th>
</tr>
</thead>
</table>

Alternatively, altimeters could be easily designed and manufactured by students, University staff and/or in external workshops.

3.2 KICK-OFF SESSION

In this session the course organization, schedule, mission objectives and statement of work will be introduced, as well as some basic theory and specific mission requirements. Starting in this session and until the end of the course, the teacher(s) adopt(s) the role of a client corporation, namely Castefa Space and Beyond Inc. (CSBI).

---

14 Many other altimeter suppliers can be found on-line.
15 The PerfectFlite MiniAlt users guide can be found in Annex D.
3.2.1 Characteristics of kick-off session

- This session takes place at a normal classroom, to be defined by Gestió Acadèmica (GA) at the beginning of the academic course
- Duration: 2h

3.2.2 Preparation of kick-off session

- The kick-off session presentations (see files) should be updated according to the new course features prior to the realization of the session
- All auxiliary educational material should be updated (e.g. data for students, Gantt Diagram, deadlines for deliveries and other milestones) according to the new course features prior to the realization of the session
- The responsible of conducting the Model Rocket Workshop (MRW) kick-off session should prepare himself for the realization of the presentation and book a projector and computer for the corresponding class, if necessary

3.2.3 Activity procedure

- Presentation of the kick-off session responsible, and the rest of the educational team (if more than one teacher participates in the management of the MRW)\(^{16}\)
- Presentation of the MRW: use presentations in the following files:
- Should the presentation last for less than the scheduled 2h, the responsible should encourage the students to use the remaining time to organize the teams (see below)
- After the kick-off session, a letter from CSBI (the kick-off letter) should be posted in Atenea-Moodle TEA course so as to indicate the students that they should start working on their respective tasks. An example of kick-off letter from CSBI is shown in Table.

Table 3.7 Kick-off letter from Castefa Space and Beyond Inc.

<table>
<thead>
<tr>
<th>Dear xxxx engineers,</th>
</tr>
</thead>
<tbody>
<tr>
<td>This (long) message contains useful information for the development of your mission. ATENEA will be used by Castefa Space and Beyond Inc. to manage the whole project and communicate with teams. You might choose to create forums for expert engineers to communicate with their analogues or to communicate within a team.</td>
</tr>
<tr>
<td>You will find also all the tasks related to your mission. Please READ carefully the description of each task. You will find an useful explanation of what are you supposed to do. On the other hand, this application will permit you to organise your work, to have an easy interaction between the members of your team and to upload your reports and results to a file repository. All the documents you hand in MUST be in PDF format and must be uploaded to ATENEA’s repositories.</td>
</tr>
<tr>
<td>According to the mission schedule, expert engineers of all teams must hold a meeting in order to discuss their job. You may find the e-mail address of all engineers involved in this course in the &quot;Participants&quot; menu, or if you prefer, you can talk with them using a forum. Remember that you must choose a secretary for each meeting who will be responsible to write and submit the minutes of the meeting. You must hold those meetings during the indicated period. Should you have any serious difficulty in contacting or arranging a meeting with all the involved engineers you can hold the meeting even if not all experts are present. In that case, this must be stated in the minutes document: who was not present and the reasons that motivated the rest of the engineers to hold the meeting without their presence.</td>
</tr>
</tbody>
</table>

\(^{16}\) For this purpose, it is recommended that all the team be present, at least at the beginning of this session.
On the other hand, I would like to remind you that all the deadlines and formats of the requested documents MUST be strictly respected. Any delay in this sense will be penalised (e.g. non allowance to attend to a particular session, for instance) and eventually you will not be allowed to launch your rocket and consequently your will be drop out of the workshop.

Please, note that ALL engineers in your team should receive this e-mail message. If it is not the case, please forward it to them.

Should you experience any other problems using ATENEA, please don't hesitate to contact us via e-mail.

Yours sincerely,

Xavier Prats and Jose I. Rojas
xavier.prats@upc.edu
rojas@fa.upc.edu

Castefa Space and Beyond Inc.

### 3.2.4 Team structure delivery

During (or at the end of) the kick-off session, the students are asked to organize teams of 5-6 members each. There is a deadline for handing in the rocket (team) name and the names of the team members. It must be specified also the role and a valid, useful e-mail of each one of the members.

### 3.3 ROLES (EXPERT ENGINEERS)

Each member of the team must be assigned a different role. The exceptions are the teams constituted of 6 members, where one role can be adopted by two persons simultaneously. In this case, it is strongly recommended that two members are assigned the Mission Engineer role (see below).

Each role has some specific responsibilities. The expert engineer acts as team's leader for the assigned specific tasks and as team's spokesman as regards to the work related to these tasks. It is important to remind that the expert engineer is only the leader for certain tasks, not the slave of those tasks. All the members of the team should participate and help the expert engineer in the specific responsibilities so all participate of the learning process. The roles or Expert Engineers (EE) are the following:

- **Mission Engineer (ME):**
  - Mission and team coordinator
  - Leader for tasks related to mission analysis: rocket equation computation and simulation
  - Team spokesman
- **Development Engineer (DE):**
  - Leader for tasks related to rocket design
  - Leader for tasks related to rocket construction
- **Test Engineer (TE):**
  - Leader for tasks related to rocket certification tests design
  - Referee for the certification tests of another rocket during certification campaign
- **Launch Engineer (LAE):**
- Leader for tasks related to rocket launching procedures design
- Supervisor during rocket launching campaign to guarantee safety
- **Ignites the rocket at the launching ramp**

- **Logistics Engineer (LOE):**
  - Leader for tasks related to rocket materials acquisition, storage and retrieval
  - Leader for tasks related to laboratory equipment well-being maintenance, manipulation and storage

3.4 MISSION ANALYSIS

The ME is the leader for the tasks related to mission analysis.

3.4.1 Preliminary trajectory simulations

This task is devoted to analysing the analytical flight trajectory. Starting from the momentum conservation law, a set of differential equations describing the trajectory of the rocket shall be obtained. This set of differential equations may be integrated by means of a simulation program, such as Octave, Matlab, Maple, etc. by using the data provided by the manufacturer of the engine. The goal of this task is to obtain a graphical representation of the main magnitudes involved in the trajectory of the rocket (velocity, altitude, position, thrust, etc.) as a function of time. You should assume an initial launch angle of 5 degrees with respect to the vertical plane perpendicular to the ground. The total mass of the rocket shall be estimated and used for this simulation. After rocket construction the same simulations will be carried out using the accurate value of mass (see task ‘Accurate Trajectory Simulations’).

3.4.2 Preliminary simulations delivery

There is a deadline for handing in the preliminary simulations report\(^\text{17}\), which is a small-size report that contains at least the following items:

- Graphical representation of the main magnitudes involved in the trajectory of the rocket
- Explanation of how the trajectory was simulated
- Attachment of the source code used for the simulation

3.4.3 Preliminary simulations crosscheck

After the preliminary simulations delivery, CSBI will provide each group with the simulation documents of one or more of the other groups. The goal of this task is to review the simulations of the other groups in order to identify possible errors or mistakes, misleading information, wrong hypotheses etc. and prepare to discuss them in the mission engineers meeting. All this information will be written in the minutes document of the mission engineers meeting.

3.4.4 Mission engineers meeting

During this week you shall hold a meeting with all the mission engineers of the rest of the groups. During this meeting you should discuss firstly how your nominal trajectory was obtained and you may try to find possible differences and/or eventual mistakes. Other mission engineers will give the opinion and the analysis results of your own simulations. You must choose a secretary for this meeting who will be responsible for submitting the minutes of the meeting before the end of the week. You will find a template for the minutes in the file repository of ATENEA-Moodle TEA course. The minutes must be uploaded in the same repository. The minutes document must contain, in addition, all the errors, corrections

\(^{17}\) All documents delivered to CSBI must meet the following requirements: 1) be in pdf format and 2) delivery is realized through upload in ATENEA-Moodle TEA course file repository.
or suggestions arisen from the preliminary simulations crosscheck task performed by each group.

3.4.5 **Accurate (final) trajectory simulations**
In this task you will run the trajectory simulation by using the actual weight of the rocket you have just constructed. Any discrepancies between these accurate simulations and the preliminary ones shall be briefly discussed.

3.4.6 **Accurate (final) simulations delivery**
There is a deadline for handing in the accurate (final) simulations report. This document shall contain at least the following items:
- The preliminary trajectory simulations
- The accurate trajectory simulations, including all additional comments issued from the mission engineers meeting and accurate simulations comparison
- The complete and final source code used in all simulations

3.5 **ROCKET DEVELOPMENT**
The DE is the leader for the tasks related to rocket design and construction.

3.5.1 **Design and construction operations**
In this task you must design a rocket able to fulfil the mission requirements, the safety code and the certification tests. You shall take into account the assigned period for the rocket construction and the 2 planned construction workshops. During the rocket construction period you can take your rocket at home, but you must not take any tool out of the laboratory. Therefore, try to plan the construction tasks and the roles of each team member carefully.

3.5.2 **Design and construction operations delivery**
There is a deadline to hand in the Design and Construction Operations document. This brief document (about 2-3 pages) shall contain, at least:
- A simplified sketch depicting the proposed rocket geometry (including characteristic dimensions and units)
- A working plan for the construction workshop session I including the tasks that will be performed by each member of the group

3.5.3 **Rocket construction**
You must build your rocket during this period of time. You should benefit as much as you can from the two construction workshops that will take place in the laboratory. During this period you can take your rocket home, but you must not take any tool out of the laboratory. Therefore, try to plan the construction tasks carefully.

**Characteristics of rocket construction sessions**
- There are 2 sessions and both take place at the Aerospace Laboratory (basement SA-1V)
- Duration of each session: 2h
- An inventory listing the available material for the students at the laboratory during the construction sessions can be found in Should a team need other materials that are not present in this inventory, the team should acquire those materials on its own
You will find there all the materials and tools needed to build your rocket. Take into account that this is the last session where you will have all the materials and facilities that the laboratory offers you.

**Preparation of rocket construction sessions**

- Buy more sprays for painting the rockets. We ran out of sprays.
- Buy more marquetry wood. We ran out of marquetry wood.
- Bring latex gloves to the 2nd session of rocket construction for the students to paint the rockets while skin contact with paints is prevented.
- Bring goggles to the 2nd session of rocket construction for the students to paint the rockets while eye contact with paints is prevented.
- Bring a white coat to the 2nd session of rocket construction for the students to paint the rockets while stains in their clothes are prevented.

**Activity procedure**

Here follow several important hints and design requirements to take into account in rocket design and construction. During the rocket certification session (see section 3.6), it should be verified whether these requirements have been fulfilled or not:

- Remember to provide the model rocket with guidance devices in order to provide rigid guidance during the launch lift-off, until the rocket has reached a speed adequate to ensure a safe flight path.
- Remember that parachutes must meet the following design requirements:
  - Enough surface area for enabling adequate sinking rate.
  - Hole in the middle so as to guarantee a stable and safe glide.
  - Adequate number and positioning of strings.
  - Special care must be taken to adequately join strings to parachute.
  - Special care must be taken for packing the parachute inside the rocket fuselage.
  - Parachute deployment must be tested.
  - Alternative design solutions: double parachute...
- Remember to dig a hole in the nose fairing to allow the air enter so as the altimeters' pressure sensors work properly.
- Remember to check that the rocket fulfills design recommendations and thumb rules (e.g. fin size and shape).
- Remember to leave a gap between the engine bracket and the metallic hook, to allow rocket engine retrieval/removing during certification session and after fuselage recovery.
- A wooden cap can be placed between the fireproof cotton and the parachutes.
- Remember to check parachute dimensions calculations of teams prior to facilitating the thermal blanket and to facilitate only an adequate surface of sheet.
- Remember to order LOE to start cleaning up 20 min prior to end of session.
- Remember to order LOE to check inventory after each construction session and especially after the last one.
- Remember to take into account the load limitations of the scale.
- Remember to insert the battery into the nose fairing and close it just before the launching. We provide the batteries. They must be returned upon utilization.
- We should implement a system such that material is not wasted in these sessions. Next some ideas are presented:
  - The supervisor should give to students only 1 item per team whenever there are 4 or more items of that type.
  - Ensure that items are returned at the end of the session: Logistics Engineer should sign in a paper upon reception and return of material.
  - The supervisor should hand a reasonable amount of fireproof cotton to each team and should not allow the teams direct access to the bags.
The supervisor should hand the parachute fabric (thermal blanket) to each team only upon presentation of their calculations referred to the parachute surface and should not allow the teams direct access to the bags. These bags might be left at the office.

### 3.5.4 Progress construction document delivery

There is a deadline to hand in the progress construction document, which shall contain at least the following items:

- Brief summary of the tasks carried out during the first construction workshop
- Self-analysis of the planned tasks and group members role during the first construction workshop
- Planning of the remaining work proving that the construction of the rocket will be finished on schedule. You may specify which tasks will be performed in the second construction workshop and which tasks will be performed (if applicable) at home, after or before this workshop.

### 3.5.5 Technical specification sheet

This task is devoted to write the technical specifications sheet of your rocket. This document must include a general description of the rocket including its main parameters (geometry, weight, surface, drag coefficients...). In addition it is also required to include detailed plans of the rocket aimed at understanding its geometry, its operation, the location of the different elements (payload, recovery systems, engine...).

### 3.5.6 Technical specifications sheet delivery

There is a deadline for handing in the Technical Specifications Sheet of your rocket. You must upload this document into the file repository of the ATENEA platform.

### 3.6 ROCKET CERTIFICATION PROCESS

#### 3.6.1 Preliminary test procedures design

In this task you will design the procedures that will be carried out during the certification process. These shall include, at least:

- A set of check-lists describing all the steps that have to be executed in each different test
- The technology and materials that you will use when executing each test
- The role of each group member during the certification session

You should keep in mind that in the laboratory you will only find digital scales that will help you to measure the forces that you will apply to the rocket. Any device to reproduce those forces and to support the rocket during the tests must be designed and provided by your group.

#### 3.6.2 Preliminary test procedures delivery

There is a deadline for handing in the preliminary test procedures designed by your team. A report containing the procedures, the involved material and the roles of each group member is expected. This report must be uploaded into the files repository of this ATENEA platform.

#### 3.6.3 Test engineers meeting

During this week you should hold a meeting with all the test engineers of the rest of the groups. During this meeting you should discuss firstly the test procedures that your group
has already designed. Then, you may work together in order to obtain a set of harmonized procedures for the certification process. The resulting procedures must be written in the form of a check-list and will be used by all the groups during the certification process.

Finally, you must choose a secretary for this meeting who will be responsible for submitting the minutes of the meeting before the end of the week. You will find a template for the minutes in the file repository of this ATENEA platform. The minutes must be uploaded in the same repository.

3.6.4 Harmonised test procedures delivery
There is a deadline for handing in the harmonized procedures delivery. Each group must upload this document, although it is the same for everybody.

3.6.5 Harmonised test procedures amendments
During this period the harmonised test procedures will be reviewed by CSBI Engineers. If it is judged worthy one or several amendments will be proposed to the delivered document.

3.6.6 Harmonised test procedures review
If applicable, the harmonised test procedures shall be reviewed according to the amendments proposed by CSBI. A new version of this document shall be issued.

3.6.7 Harmonised test procedures approval
At this date the test procedures approval shall be issued. This document shall contain the very last version of the test procedures harmonised document, containing (if applicable) all amendments. The final document must be uploaded by each group in the ATENEA platform, even if it is the same document for everybody.
3.6.8 Rocket certification session

Your team must demonstrate that the rocket is ready to obtain the airworthiness certification by successfully passing all the certification tests.

Characteristics of rocket certification session

- This session takes place at the Aerospace Laboratory (basement SA-1V) and outside EETAC buildings
- Duration: 2h

Preparation of rocket certification session

- Post the following message in Atenea-Moodle TEA – MRW – Test Engineers Forum (and, just in case, post it also in Atenea-Moodle TEA News Forum) (see Table 3.8):

  Table 3.8 Message to Test Engineers prior to Rocket Certification Session.

TEA – MRW – Test Engineers Forum – Test Session:

This is a message to the test engineers:

Please, print a copy of the certified test procedures and bring it to the test session (to be held in YYYY-MM-DD, at HH:HH h, at the Aerospace Laboratory SA-1V). Get in contact with the Logistics Engineers so to remind them to bring also all the material/equipment you need for the realization of the tests that is not already available in the laboratory.

This is a message to all of MRW participants:

Bring all the material/equipment you need for the realization of the tests that is not already available in the laboratory. Bring also all necessary numerical values from the rocket motion simulation in order to calculate the forces to apply on the rocket during the tests.

- Post also the activity procedure so each team can read it and be prepared
- Attach the final harmonized test procedures (Certified Test Procedures) to this message, which must have been delivered well in advance to the certification session
- (Just in case) Prepare a copy (one per team plus one for the teacher) of the final harmonized test procedures (Certified Test Procedures)
- Check the status of the batteries for the scales and buy new ones if necessary (two 1.5V batteries for one scale and a 9V battery for the other)
- Check the status of the batteries for the altimeters and buy new ones if necessary (ideally, one 9V battery for each rocket is necessary)
- Reload the walkie-talkie batteries

Activity procedure

- Bring photocopies of final harmonized test procedures (Certified Test Procedures) and give one copy to each Test Engineer
- Bring protractors, rulers, compasses, walkie-talkies, etc. in case they are needed
- Split the class into rocket teams
- Pass a copy to each team that forgot to print its own copy
- Each table is assigned a test (or group of tests, depending on the number of tables and the test procedures) and the materials and equipment needed for the respective test(s) must be placed there
• Each team \((i=1\ldots n)\) and respective rocket are assigned an initial table \(i\)
• Test Engineer of team \(i\) will supervise the certification process of rocket \(i+1\) in all the tables
• Members of team \(i\) will perform the certification tests to their own rocket \(i\), in all the tables, according to instructions specified in final harmonized test procedures, under the supervision of the Test Engineer of team \(i-1\)
• Both the Test Engineer of team \(i-1\) and a representative of team \(i\) will sign each test report in the final harmonized test procedures, stating the result:
  - Passed
  - Failed + reason(s) why the test failed
  - Pending + reason(s) why the test has not been performed
• Once all the teams have finished the test(s) in their respective initial table, or after passed 2h/#tables min, each team moves to the following table (team \(i\) moves to table \(i+1\)).
• The iterative process is repeated every 2h/#tables min until the certification is completed
• Check that the students are performing the tests properly
• Check that each rocket fulfils the following:
  - There is a hole in the center of the parachute
  - There is a hole in the nose fairing that communicates the external atmosphere with the interior cabin where the altimeter sensor is located
  - There is a 5 cm gap between the lower section of the engine (end of the nozzle) and the launch pad
  - The engine hook is placed in such a manner that there is a gap bigger than 0.5 cm between it and the lower border of the engine bracket
• At the end of the activity, the representative of team \(i\) (the Mission Engineer or the Test Engineer) will deliver to Castefa and Beyond Inc. the final harmonized test procedures filled with the results for rocket \(i\)
• Ask the students to give back (return) all material belonging to EETAC (e.g. the batteries, rocket engines, altimeters) after the test session is finished

Comments on the test session
During MRW test session in QT08-09, for 6 rocket teams, it worked pretty well to split all of the tests in 6 blocks of around 2 tests each. Allocating 15 min to perform each block (7.5 min per test) worked pretty well also. The tests (see certified test procedures from QT08-09) were split as follows:
• Block 1 was constituted of tests #1 and #5
• Block 2 was constituted of tests #2 and #3
• Block 3 was constituted of tests #6 and #4
• Block 4 was constituted of tests #6 and #9
• Block 5 was constituted of tests #7 and #8
• Block 6 was constituted of tests #10 and #11

3.7 LAUNCH OPERATIONS

3.7.1 Preliminary launch procedures design
In this task you will design the procedures that will be carried out during the launch campaign. These shall include, at least:

• A set of check-lists describing all the steps that have to be executed prior to launch, during the final countdown and launch, and during the rocket and payload recovery
• A statement of tasks that each member of your team will perform during the launch operations. Remember that the launch engineer must be the head commander of the launch.

• A set of contingency and emergency procedures that will try to cope with any failure or unexpected event. You should consider at least:
  - Electrical ignition failure
  - Backup ignition failure
  - Rocket explosion
  - Dangerous rocket trajectory
  - Altimeter failure
  - Wounded people
  - Difficult or hazardous rocket recovery
  - Adverse meteorological conditions
  - Strong winds
  - Etc. (use your imagination!)

3.7.2 Preliminary launch procedures delivery
There is a deadline for handing in the preliminary launch procedures designed by your team. A report containing the launch check-lists, the duties of each member of your group and the contingency and emergency procedures is expected. This report must be uploaded into the files repository of this ATENEA platform.

3.7.3 Launch engineers meeting
During this week you should hold a meeting with all the launch engineers of the rest of the groups. During this meeting you should discuss firstly the launch procedures that your group has already designed. Then, you may work together in order to obtain a set of harmonized procedures for the launch. The resulting procedures must be written in the form of a check-list and will be used by all the groups during the launch process. You shall include the duties of each member of the team during the launch and the contingency and emergency measures.

On the other hand, you must choose a secretary for this meeting who will be responsible for submitting the minutes of the meeting before the end of the week. You will find a template for the minutes in the file repository of this ATENEA platform. The minutes must be uploaded in the same repository.

Finally you must perform a visual inspection of the campus surrounding the EETAC building and make an assessment of the potential launch sites. This brief study should conclude to one or two selected sites and you must note them in the minutes document (explaining the advantages and/or disadvantages).

3.7.4 Harmonised launch procedures delivery
There is a deadline for handing in the harmonized procedures delivery. Each group must upload this document, although is the same for everybody.

3.7.5 Harmonised launch procedures amendments
During this period the harmonised launch procedures will be reviewed by CSBI Engineers. If it is judged worthy one or several amendments will be proposed to the delivered document.

3.7.6 Harmonised launch procedures review
If applicable, the harmonised launch procedures shall be reviewed according to the amendments proposed by CSBI. A new version of this document shall be issued.
3.7.7 Harmonised launch procedures approval

At this date the launch procedures approval shall be issued. This document shall contain the very last version of the launch procedures harmonised document, containing (if applicable) all amendments. The final document must be uploaded by each group in the ATENEA platform, even if it is the SAME document for everybody.

3.7.8 Launching campaign

Launch campaign window

This is the period of time where the launch campaign could take place. The exact date, time and location will be confirmed by CSBI shortly before the D day. Mr. J.L. Cortijos is the President of the Club Spain Rocketry (https://postgrau.upc.edu/aerospace/links), which is devoted to promoting rocketry. They launch their rockets from Rosselló, close to Lleida. We have been offered by him to launch our MRW rockets from their launch site.

Characteristics of launching campaign
- This session takes place at Campus terrain
- Duration: 2h

Preparation of launching campaign
- Post a message in Atenea-Moodle TEA – MRW – Test Engineers Forum (and, just in case, post it also in Atenea-Moodle TEA News Forum) as follows (Just in case) Prepare a copy (1 per team) of the final harmonized launch procedures, which must have been delivered well in advance
- Charge walkie-talkies
- Tell students to bring chronometers
- Obtain tools for cutting and peeling wires and screwdriver (necessary for installing the altimeters)

Activity procedure
- Bring photocopies of final harmonized launch procedures
- Bring all necessary materials and equipment:
  - wire and cutter
  - walkie-talkies
  - anemometer
  - screwdriver
  - chronometers
  - pen to take notes of readings and observations
  - as many envelopes as teams
- Remember to measure and to note down the readings of:
  - time from take-off to maximum height
  - time from maximum height to landing of fuselage
  - time from maximum height to landing of nose-fairing
  - horizontal distance from launching pad to landing site of nose-fairing and fuselage
- Remember to recover the batteries and altimeters from each team
- Remember to put each team’s altimeter inside a named envelope after recovery

3.8 RECOVERY OF ALTIMETER DATA

- Install PerfectFlite MiniAlt software in your computer from CD and execute (or directly execute in the CD) the file: \Data Transfer Software\miniAlt Software for Windows\MAWD DataCap
- Connect RS-232 wire to RS-232 CPU port and to PerfectFlite DT2x Serial I/O
- Connect PerfectFlite DT2x Serial I/O to altimeter
Compendium of Procedures: TEA

Supply the altimeter with electrical power (9V)

When hearing a bip sound, quickly click in PerfectFlite MiniAlt software menus:
- Altimeter > CommPort > Select Port: COM1
- Data > Acquire
- File > Save as… (use team name)

Press Print Screen key, then execute MS Paint, paste there and save the plot as an image (e.g. JPG, JPEG, GIF, TIF) (use team name) (see an example in Fig. 2)

Send the image to respective team or post them in ATENEA-Moodle TEA course

3.9 FLIGHT DATA PROCESSING AND FINAL REPORT

After students have received the altimeter data and performed the data processing, a final report shall be written with at least the following sections:

- Description of the launch operations during D day
- Description of the altimeter data
- Comparisons between real data and simulated trajectory
- Discussion in order to explain possible differences
- Any other useful information concerning the launch and the trajectory
- A list of suggestions and recommendations, based on the experience learned, aimed at improving the results if the mission had to be repeated.
3.10 FINAL PRESENTATION: THE PRESS CONFERENCE SESSION

The press conference session is the last session of the course and is reserved for the teams to do the final public presentation of their results. The date constitutes also the deadline for handing in the final report.

3.10.1 Characteristics of the press conference session

- This session takes place at a normal classroom, to be defined by Gestió Acadèmica (GA) at the beginning of the academic course
- Duration: 2h

3.10.2 Preparation of the press conference session

- Prepare copies (1 per student) of the evaluation form, that can be found in annexe X or the file
- The responsible of conducting the MRW press conference session should prepare himself for the session and book a projector and computer for the corresponding class, if necessary

3.10.3 Remarks on the final presentation

- The final presentation must be performed in English (slides and oral explanations)
- The number of team members participating in the presentation is up to you (from our stand point, the more people the better)
- Ideally the Mission Engineer should be the conductor/main speaker/presenter and she/he should be assisted/substituted by the rest of the members in each particular part of the presentation
- The presentations should last for 15 min approximately (3 min will be allocated for questions from the audience in the aftermath)
- ALTITUDE READINGS (MEASUREMENTS) OBTAINED BY THE ALTIMETERS ON-BOARD THE ROCKETS: the altimeter readings have been sent to the corresponding mission engineers
- Sections to be included in the final report and presentation:
  o Description of your launch operations during launch day
  o Description of the data acquired by the altimeter
  o Comparisons between acquired altitude data and simulated trajectory
  o Discussion to explain differences between real and simulated trajectory
  o Any other useful information concerning the launch and the trajectory
  o Lessons learned: list of suggestions and recommendations, based on the experience you gained, aimed at improving your results in the case you had to repeat the mission

3.10.4 Activity procedure

- Bring the copies of the evaluation form
- Each team member should fill an evaluation form so teamwork can be evaluated
- Each team will have 10-20 min to perform the final presentation, depending on the number of teams
- There are several options for the teams to do the presentation. The valid one should be chosen by CSBI and explained to the teams well in advance. On the contrary, CBSI could allow the teams to chose the option they prefer:
  - All the team members speak in the presentation
  - Only some team members speak in the presentation
Only one member of team speaks in the presentation. In this case, CBSI could allow the team to choose its spokesman or could decide the spokesman at random.

3.11 FUTURE WORK

- Renew, rebuild or improve the existing launch pad, which is seriously degraded
- Check the feasibility of using the Rocket Simulator freeware
- Another idea is that students should calculate the fins’ dimensions using stability analysis instead of thumb rules (e.g., calculations of forces on fins and moments referred to the gravity centre due to velocity)
- Ensure that students read the altimeter users guide
- Improve the rocket motion equations integration and simulation process
- Batteries are too heavy. Several proposals are:
  o to increase the power of the rockets (up to category G no license is needed for rocket engine operation) taking into account that higher altitudes may be more dangerous depending on the launching site;
  o a circuit could be implemented so to use smaller batteries;
  o the students or Serveis Tècnics may design a cheaper, better altimeter

3.12 DETECTED DEFECTS DURING THE COURSE OF MRW

- The saws need more teeth and compatible handles
- Buy more marquetry wood and good saws
- Remember to buy the missing items in the inventory: sand paper, etc.
- Ensure that students read the altimeter users guide
- The load limit for one of the scales is only 5 Kg, which may be problematic
- Attention must be paid to excess weight (overweight as regards to maximum recommended take-off weight)
- Altimeters do not function adequately
- Parachute deployment
The purposes of this hands-on activity are several. On the one hand, we intend the students to learn the basics of Satellite Tool Kit (STK). On the other hand, our will is to teach the students the basics of orbital mechanics, the different types of Earth orbits, the different commercial and scientific missions each of these orbits is suited to, according to the orbital elements, and other parameters like orbit altitude, revisit time, etc. Other concepts to be introduced along this workshop are ground-track, coverage of a sensor on-board a satellite and coverage of a ground station, etc. The students will learn about all these topics through the utilization of STK as part of the STK learning process itself.

In further hands-on activities, the students will learn about mission analysis and trajectory design with specific requirements (design of optimal orbits according to mission objectives, etc.), as well as perturbations for satellite orbits, etc.

4.1 Exercise 1: Learning the basis

4.1.1 Exercise preparation

It is mandatory for the students to study and understand the meaning of the following concepts prior to this hands-on activity:

- Earth’s gravitational field J2 Perturbation
- Orbit inclination, eccentricity, semi-major axis, altitude and radius
- Orbit apoapsis and periapsis and (in particular, orbit apogee and perigee)
- Ground-track of a space object
- Area coverage (foot-print) of a sensor
- Cone angle and Field of View (FOV) of a sensor
- Latitude and longitude
- Low Earth Orbit (LEO), geosynchronous orbit, Geostationary Earth Orbit (GEO)
- Ascending node and descending node (longitude of ascending node)

A warning message to students regarding this issue should be posted (in the corresponding Atenea-Moodle course\(^{18}\)) well in advance prior to the realization of this exercise. Students should be encouraged to print these guidelines for the activity and they should be told they must study the concepts above. Students should be asked for authorization to use their personal data (see Section 404.6).

\(^{18}\) This task can only be done by teachers who have editing privileges for the corresponding course.
Explain what the Earth’s gravitational field J2 Perturbation is:

Draw a couple of views of an orbit and indicate the following: inclination, eccentricity, semi-major axis, altitude and radius, apoapsis and periapsis, ascending node and descending node.

Explain which are the features of a Low Earth Orbit (LEO), a geosynchronous orbit and a Geostationary Earth Orbit (GEO):

4.1.2 Briefing

The students will create a new spacecraft (S/C) (equipped with a sensor) and a new ground station. Some of the elements of the spacecraft’s orbit will be set as they are for the International Space Station (ISS) (e.g. orbit inclination, maximum orbit altitude, and minimum orbit altitude). The students will animate the scenario to view the behaviour of the satellite and to view the other elements. In addition, the students will report accessibility (visibility) between the sensor on-board the satellite and the ground station in several cases, thus witnessing how the variation of some of the orbit and/or sensor parameters affects this accessibility.

4.1.3 Procedure: Definition of the scenario

Here follows a proposed step-by-step procedure that students should follow during the course of Exercise 1:

1. Start a new scenario: Left click: File > New Scenario
2. Define a new satellite:
a. Left click: **Insert > New… > Satellite**
b. Right click: **Satellite1**
c. Left click: **Properties Browser**
   i. Select: **Basic > Orbit**
   ii. Change **Propagator** to J2Perturbation
   iii. Set **Inclination** to 51.64 degrees (inclination of the ISS orbit)
   iv. Change pull-down menu from **Semi-major Axis** to **Apogee**
   v. Set **Apogee Altitude** to 1000 Km
   vi. Set **Perigee Altitude** to 1000 Km
   vii. Left click: **OK**
d. Left click: **Reset** button

3. Define a new sensor on-board **Satellite1**:
   a. Left click (highlight): **Satellite1** in the **Object Browser** window
   b. Left click: **Insert > New… > Sensor**
   c. Right click: **Sensor1**
   d. Left click: **Properties Browser**
      i. Select: **Basic > Definition**
      ii. Set **Cone Angle** (which is the FOV20) to 75 degrees
      iii. Select: **2D Graphics > Attributes**
      iv. Customize: **Color, Line Style** and **Line Width**
      v. Left click: **OK**

4. Animate satellite:
   a. Left click: **Start** button
   b. Slow down or speed up the animation using **Decrease Time Step** or **Increase Time Step** buttons
   c. Identify the ground-track of **Satellite1** and area of coverage of **Sensor1**
   d. Return to original position: Left click: **Reset** button
   e. View the animation in 2D and 3D mode (when possible)

5. Define a ground station at EETAC:
   a. Left click (highlight): **Scenario1**
   b. Left click: **Insert > New… > Facility**
   c. Right click: **Facility1**
   d. Left click: **Properties Browser**
      i. Set location of ground station at EETAC. Set **Latitude** to 41.27 degrees (latitude North is positive latitude) and **Longitude** to 1.98 degrees (longitude East is positive longitude)
      ii. Left click: **OK**

6. Check access (visibility) **Satellite-Satellite1-Sensor-Sensor1-To-Facility-Facility1**:  
   a. Right-click: **Sensor1**
   b. Left click: **Sensor Tools > Access**
   c. Left click (highlight): **Facility1** in the **Associated Objects** box
   d. Left click: **Access…** in the **Reports** box
   e. Find out the meaning of the information in this new tab: **Report: Satellite-Satellite1-Sensor-Sensor1-To-Facility-Facility1 – Access:**
   f. Fill in the empty boxes in Section 4.1.4
   g. Animate satellite (see step 4). Check the correspondence between the reported accesses and the accesses as seen in the animation

7. Change **Satellite1** and **Sensor1** parameters:
   a. Decrease **Apogee Altitude** to 278 Km
      i. Left click (highlight): **Satellite1**

---

19 These 2 operations (2.b and 2.c) can be substituted at any time by double clicking on **Satellite1**.
20 Find out the meaning of this concept if necessary (e.g. perform a search on-line or among your class notes).
21 Clicking the **OK** button closes the corresponding tab. On the contrary, if **Apply** button is clicked, the settings are updated also but the tab is retained for further use later on.
ii. Right click: Satellite1
iii. Left click: Properties Browser
iv. Set Apogee Altitude to 278 Km (min altitude of ISS orbit)
v. Set Perigee Altitude to 278 Km (min altitude of ISS orbit)
vi. Left click: OK
vii. Animate satellite (see step 4). Identify the differences in the 2D and 3D views as compared to the previous animation
b. Repeat step 6. Identify the changes in the access report
c. Fill in the empty boxes in Section 4.1.4
d. Try playing a bit and change other parameters. Identify the effects on the orbit, ground-track, coverage, etc. when changing a parameter by viewing the orbit in 2D and 3D mode (when possible). Suggestions:
i. Set orbit altitude back to 1000 Km and change Sensor1’s Cone Angle to 40 degrees (see step 3)
ii. Change Satellite1’s orbit. Change pull-down menu from Apogee Altitude to Apogee Radius and then change values of Apogee Radius and/or Perigee Radius. Customize units
iii. Change Satellite1’s orbit. Change pull-down menu from Apogee Radius to Period and change Period and/or Eccentricity
iv. Change Satellite1’s orbit. Change pull-down menu from Period to Mean Motion and change Mean Motion and/or Eccentricity
v. Change Satellite1’s orbit. Change pull-down menu from RAAN to Lon. Ascn. Node (longitude of the ascending node) and then change the Lon. Ascn. Node
vi. Set orbit altitude to 460 Km (max altitude of the ISS orbit)
8. Reset all parameters back to the status prior to step 7 (orbit altitude should be 1000 Km, Sensor1 Cone Angle 75º and orbit Inclination 51.64º)
9. Save scenario as Scenario_Exercise1_Name_Group: Left click: File > Save
10. Exit: Left click: File > Exit

4.1.4 Questions
For the reference day in STK, students should note down the following information about Satellite-Satellite1-Sensor-Sensor1-To-Facility-Facility1 access:

| For orbit altitude 1000 Km, orbit Inclination 51.64º and Sensor1 Cone Angle 75º |
|-------------------------|-----------|-----------|-----------|-----------|
| Number of times satellite is accessible [-] | 7         |
| Min duration of access [sec] | 902.301   |
| Max duration of access [sec] | 1111.839  |
| Mean duration of access [sec] | 1047.308  |
| Total duration of access [sec] | 7331.155  |

| For orbit altitude 278 Km, orbit Inclination 51.64º and Sensor1 Cone Angle 75º |
|-------------------------|-----------|-----------|-----------|-----------|
| Number of times satellite is accessible [-] | 7         |
| Min duration of access [sec] | 344.030   |
| Max duration of access [sec] | 526.686   |
| Mean duration of access [sec] | 455.768   |
| Total duration of access [sec] | 3190.379  |

Students should also answer the following questions after or while performing step 7 in Section 4.1.3:
1. What happens to the total duration of Satellite-Satellite1-Sensor-Sensor1-To-Facility-Facility1 access when changing the orbit altitude from 1000 Km to 278

22 Name and group are the student’s name and group.
Km while the rest of the parameters remain unchanged? Why do you think this happens?

2. What happens to the total duration of Satellite-Satellite1-Sensor-Sensor1-To-Facility-Facility1 access when changing the Sensor1’s Cone Angle while the rest of the parameters remain unchanged? Why do you think this happens?

3. How much is the Eccentricity for a circular orbit? What happens to Eccentricity when the Apogee Radius and the Perigee Radius are different? Where are the apogee and the perigee for a circular orbit?

4. For a circular orbit of Period equal to 1 day or Mean Motion equal to 1 revs/day, how much is the Apogee Altitude and Apogee Radius? If the orbit Inclination is set to 0 degrees, what kind of orbit is this? Which is the shape of the ground-track in this case? What happens to the ground-track if the orbit Inclination is set to 25 degrees? What kind of orbit is this? What happens when the longitude of the ascending node is changed?
4.1.5 Conclusions

Through the realization of this exercise the students learn the basis of STK operation to create satellites, sensors and ground stations, to set and change some of their features adequately and to animate scenarios. In addition, the students learn how to report accessibility (visibility) between sensors on-board satellites and ground stations, and also witness how the variation of some of the orbit and/or sensor parameters affects this accessibility. The former will help them better understand the meaning of orbit parameters like inclination, eccentricity, semi-major axis, altitude, radius, etc.

4.2 Exercise 2: Tracking antenna in a ground station

4.2.1 Exercise preparation

It is mandatory for the students to study and understand the meaning of the following concepts prior to this hands-on activity:

- Telemetry, Tracking and Command (TTC)
- Uplink and downlink
- Payload and bus (platform)
- Payload and housekeeping data
- Link budget

A warning message to students regarding this issue should be posted (in the corresponding Atenea-Moodle course) well in advance prior to the realization of this exercise. Students should be encouraged to print these guidelines for the activity and they should be told they must study the concepts above. Students should be asked for authorization to use their personal data (see Section 4.0.6). As will be seen, it is also necessary that students do Exercise 1 (see Section 4.1) prior to Exercise 2.

<table>
<thead>
<tr>
<th>Explain what is the meaning of Telemetry, Tracking and Command (TTC), uplink and downlink and payload data and housekeeping data:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Explain what is the meaning of payload and bus (or platform), and list the subsystems of the platform:</th>
</tr>
</thead>
</table>
4.2.2 Briefing

The students will create a new sensor located at the ground station of Exercise 1 (see Section 4.1). In this case, the new sensor can be thought as representing one of the antennae of the ground station. For instance, the purpose of this antenna would be to perform the tracking\(^{20}\) of the spacecraft, to transmit (uplink\(^{20}\)) control orders (telecommand\(^{20}\)) to the spacecraft and/or receive (downlink\(^{20}\)) telemetry\(^{20}\) data (payload\(^{20}\) and housekeeping\(^{20}\) data) from it. The students will change the pointing features of this sensor and will verify the differences between fixed pointing and targeted pointing sensors. In addition, the students will report accessibility (visibility) between the sensor in the ground station and the satellite in several cases, thus witnessing how the variation of some of the orbit and/or sensor parameters affects this accessibility.

4.2.3 Procedure: Definition of the scenario

Here follows a proposed step-by-step procedure that students should follow during the course of Exercise 2\(^{23}\):

1. Open Scenario_Exercise1_Name_Group: Left click: File > Open
2. Check that orbit altitude is 1000 Km, Sensor1 Cone Angle is 75 degrees and orbit Inclination is 51.64 degrees. On the contrary, reset to these values
3. Define a new sensor in the ground station Facility1:
   a. Left click (highlight): Facility1 in the Object Browser window
   b. Left click: Insert > New… > Sensor
   c. Right click: Sensor2 (for instance, an antenna in the ground station)
   d. Left click: Properties Browser
      i. Select: Basic > Definition
      ii. Set Cone Angle to 15 degrees
      iii. Select: 2D Graphics > Attributes
      iv. Customize: Color, Line Style and Line Width
      v. Left click: OK
4. Check access Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1:
   a. Right-click: Sensor2
   b. Left click: Sensor Tools > Access
   c. Left click (highlight): Satellite1 in the Associated Objects box
   d. Left click: Access… in the Reports box
   e. Fill in the empty boxes in Section 4.2.4
   f. Animate satellite. Check the correspondence between the reported accesses and the accesses as seen in the animation
5. Change sensor parameters:
   a. Right click: Sensor2
   b. Left click: Properties Browser
      i. Select: Basic > Pointing
      ii. Change Pointing Type from Fixed to Targeted
      iii. Left click (highlight): Satellite1
      iv. Left click on arrow so Satellite1 (in the Available Targets box) is moved to the Assigned Targets box\(^{24}\)
      v. Left click: OK
6. Check again access Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1:
   a. Right-click: Sensor2
   b. Left click: Sensor Tools > Access

---

\(^{23}\) Exercise 2 uses the scenario defined in Exercise 1 as starting point so Exercise 1 (see Section 4.1) should be realized prior to Exercise 2.

\(^{24}\) With all other concepts set to default settings, this means that the ground station’s antenna pointing is changed from pointing always in a fixed direction to aiming at the assigned target(s) (Satellite1). Then, the sensor’s footprint appears in the graphics window only when the target is in view, as determined by the sensor’s constraints and the targeted object’s constraints. A targeted tracking sensor slews or tracks an assigned target as soon as it appears over the horizon.
c. Left click (highlight): **Satellite1** in the **Associated Objects** box
d. Left click: **Access…** in the **Reports** box
e. Fill in the empty boxes in Section 4.2.4
f. Animate satellite. Check the correspondence between the reported accesses and the accesses as seen in the animation

7. Change Satellite1 and Sensor2 parameters:
   a. Change Sensor2's **Cone Angle** in **Fixed** and **Targeted Pointing Type** and identify the effects on access in both cases
   b. Change orbit altitude in **Fixed** and **Targeted Pointing Type** and identify the effects on access in both cases

### 4.2.4 Questions

For the reference day in STK, students should note down the following information about **Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1** access:

<table>
<thead>
<tr>
<th>For orbit altitude 1000 Km, orbit inclination 51.64°, Sensor2 Cone Angle 15° and</th>
<th>Fixed Pointing Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of times satellite is accessible [-]</td>
<td>1</td>
</tr>
<tr>
<td>Min duration of access [sec]</td>
<td>76.295</td>
</tr>
<tr>
<td>Max duration of access [sec]</td>
<td>76.295</td>
</tr>
<tr>
<td>Mean duration of access [sec]</td>
<td>76.295</td>
</tr>
<tr>
<td>Total duration of access [sec]</td>
<td>76.295</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For orbit altitude 1000 Km, orbit inclination 51.64°, Sensor2 Cone Angle 15° and</th>
<th>Targeted Pointing Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of times satellite is accessible [-]</td>
<td>7</td>
</tr>
<tr>
<td>Min duration of access [sec]</td>
<td>902.286</td>
</tr>
<tr>
<td>Max duration of access [sec]</td>
<td>1111.831</td>
</tr>
<tr>
<td>Mean duration of access [sec]</td>
<td>1047.297</td>
</tr>
<tr>
<td>Total duration of access [sec]</td>
<td>7331.077</td>
</tr>
</tbody>
</table>

Students should also answer the following questions after or while performing the procedure in Section 4.2.3:

1. What happens to the total duration of **Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1** access when changing **Pointing Type** from **Fixed** to **Targeted** while the rest of the parameters remain unchanged? Why do you think this happens? Provided we need to maximize the amount of downloaded data from the S/C to the station, what kind of **Pointing Type** is the optimum if we suppose that the rest of the parameters remain unchanged (e.g. sensors’ downlink bandwidth)?

2. What happens to the total duration of **Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1** access when changing the **Sensor2's Cone Angle** in **Fixed Pointing Type** while the rest of the parameters remain unchanged? Why do you think this happens?
3. What happens to the total duration of Facility-Facility1-Sensor-Sensor2-To-Satellite-Satellite1 access when changing the Sensor2’s Cone Angle in Targeted Pointing Type while the rest of the parameters remain unchanged? Why do you think this happens?

4.2.5 Conclusions
Through the realization of this exercise the students learn the basis of STK operation to set and change the pointing features of sensors. In addition, the students learn how to report accessibility (visibility) between sensors in ground stations and satellites, and witness how the variation of some of the orbit and/or sensor parameters affects this accessibility. Also, the students have had the chance to check the benefits of targeted pointing sensors (e.g. a movable tracking antenna) versus fixed pointing sensors (e.g. a fixed tracking antenna) for TTC purposes (i.e. in general, data transmission rate between the S/C and the ground stations is requested to be as high as possible). A movable tracking antenna that targets the S/C allows the time duration of access (visibility) to be increased thus increasing the amount of transmitted data for a given bandwidth. Another important conclusion is that the antenna’s Cone Angle is a critical parameter for access when the antenna is of Fixed Pointing Type while has no influence on access when the Pointing Type is Targeted.

4.3 Exercise 3: Types of orbits

4.3.1 Exercise preparation
It is mandatory for the students to study and understand the following orbits and identify their characteristics prior to this hands-on activity:

- LEO
- Medium Earth Orbits (MEO)
- Geosynchronous orbits
- GEO
- Highly Elliptical Orbits (HEO)
- Polar orbits and Sun Synchronous Orbits (SSO)
- Molniya, Tundra and Cobra type orbits

A warning message to students regarding this issue should be posted (in the corresponding Atenea-Moodle course) well in advance prior to the realization of this exercise. Students should be encouraged to print these guidelines for the activity and they should be told they...
must study the concepts above. Students should be asked for authorization to use their personal data (see Section 404.6). It is also recommended that students do Exercise 1 (see Section 4.1) prior to Exercise 3. Otherwise, it would be necessary that students learn by themselves some basic STK commands, which is neither very difficult nor time consuming if the STK tutorials are used.

- Explain which are the features of Highly Elliptical Orbits (HEO), Medium Earth Orbits (MEO) and Polar orbits and Sun Synchronous Orbits (SSO):

- Explain which are the features of Molniya, Tundra and Cobra type orbits:

### 4.3.2 Briefing
The students will create 9 new satellites as done in Exercise 1 (see Section 4.1). The students will choose the values of the parameters of the orbit in such a way that each satellite will be placed in a different orbit: in LEO, MEO, geosynchronous orbit, GEO, HEO, polar orbit and SSO, and Molniya, Tundra and Cobra orbits. If time is to be saved or the exercise is considered too repetitive, some orbits may be quitted (e.g. HEO, Tundra and Cobra orbit may be skipped, since the former two are quite related to Molniya orbits and all these orbit types are HEO, being Molniya the most famous).

### 4.3.3 Procedure: Definition of the scenario
Having performed Exercise 1 and 2 (see Sections 4.1 and 4.2), and having studied and found the characteristics of the above mentioned orbits, the students now have the tools and knowledge to create the 9 satellites by themselves as requested, hence no procedure is listed here.

### 4.3.4 Questions
For each satellite’s orbit, the students should fill in the blanks with the chosen values for each of the following parameters:
## Compendium of Procedures: TEA

### Low Earth Orbit (LEO)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td></td>
</tr>
<tr>
<td>Period [sec]</td>
<td></td>
</tr>
<tr>
<td>Eccentricity</td>
<td></td>
</tr>
</tbody>
</table>

### Medium Earth Orbit (MEO)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td></td>
</tr>
<tr>
<td>Period [sec]</td>
<td></td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td></td>
</tr>
</tbody>
</table>

### Geosynchronous orbit

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td></td>
</tr>
<tr>
<td>Period [sec]</td>
<td>86400</td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td></td>
</tr>
</tbody>
</table>

### Geostationary Earth Orbit (GEO)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td>35863</td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td>35863</td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td>0</td>
</tr>
<tr>
<td>Period [sec]</td>
<td>86400</td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td>0</td>
</tr>
</tbody>
</table>

### Highly Elliptical Orbit (HEO)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td></td>
</tr>
<tr>
<td>Period [sec]</td>
<td></td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td></td>
</tr>
</tbody>
</table>

### Polar orbit (SSO)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td>83 or 97</td>
</tr>
<tr>
<td>Period [sec]</td>
<td></td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td></td>
</tr>
</tbody>
</table>

### Molniya orbit

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apogee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Perigee altitude [Km]</td>
<td></td>
</tr>
<tr>
<td>Inclination [degree]</td>
<td>63.4</td>
</tr>
<tr>
<td>Period [sec]</td>
<td>43200</td>
</tr>
<tr>
<td>Eccentricity [-]</td>
<td></td>
</tr>
</tbody>
</table>
### Compendium of Procedures: TEA

#### 4.3.5 Conclusions

Through the realization of this exercise the students learn the most important orbits and their different features: LEO, MEO, geosynchronous orbits, GEO, HEO, polar orbits, SSO and Molniya, Tundra and Cobra orbits.

#### 4.4 Exercise 4: Mission analysis

##### 4.4.1 Exercise preparation

This exercise is intended to summarize all topics considered in the previous exercises (see Sections 4.1, 4.2 and 4.3) and in regular classes. Hence it is strongly recommended the students to do and fully understand those exercises. It would be also advisable for them to study in-depth the class notes so they master some of the concepts they will need to properly perform in the frame of this exercise. A warning message to students regarding these issues should be posted (in the corresponding Atena-Moodle course) well in advance prior to the realization of this exercise. Students should be encouraged to print these guidelines for the activity and they should be told they must study the concepts above. Students should be asked for authorization to use their personal data (see Section 404.6).

##### 4.4.2 Briefing

The students will be requested to design a space mission that fulfils the proposed mission requirements as stated below. Here follow some examples of the missions that the students will have to design:

- Telecommunications satellite
- Earth Observation (EO) satellite

---

<table>
<thead>
<tr>
<th>Tundra orbit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apogee altitude [Km]</strong></td>
</tr>
<tr>
<td><strong>Perigee altitude [Km]</strong></td>
</tr>
<tr>
<td><strong>Inclination [degree]</strong></td>
</tr>
<tr>
<td><strong>Period [sec]</strong></td>
</tr>
<tr>
<td><strong>Eccentricity [-]</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cobra orbit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apogee altitude [Km]</strong></td>
</tr>
<tr>
<td><strong>Perigee altitude [Km]</strong></td>
</tr>
<tr>
<td><strong>Inclination [degree]</strong></td>
</tr>
<tr>
<td><strong>Period [sec]</strong></td>
</tr>
<tr>
<td><strong>Eccentricity [-]</strong></td>
</tr>
</tbody>
</table>

Students should also answer the following questions after or while performing this exercise:

1. Which are the differences between the ground tracks of these orbits?
Through this exercise, the students will learn the process of mission analysis and design.

### 4.4.3 Procedure: Definition of the scenarios

Having performed Exercise 1, 2 and 3 (see Sections 4.1, 4.2 and 4.3), the students now have the tools and knowledge to do this exercise on their own, hence no procedure is listed here.

### 4.4.4 Questions

Students have to design a space mission that fulfils the proposed mission requirements for each of the following cases:

1. **Telecommunications satellite**:
   a. Has to give 24h per day coverage to Europe (up to 65° latitude North and longitude ranging from -30° to +30°)
   b. Has to be viewed 24h per day by non-movable (fixed) antennae on ground
   c. Has to

2. **EO satellite**:

3. **Reconnaissance satellite (spy satellite)**:
   a.

### 4.5 Exercise 5:

1. **Change Satellite Orbit Attributes**
   a. Right click **Satellite1** and Select **Properties Browser**
   b. Set **Eccentricity** to 0.7
   c. Set **Inclination** to **63.4 degrees**
   d. Change pull-down menu from **Mean Motion (revs/day)** to **Semi-major Axis**
   e. Change **Semi-major Axis** to 26 500 km
   f. Change **Argument of perigee** to **270 degrees**
   g. Make sure that the propagator is **J2Perturbation**
   h. Click on: **Apply**

2. **Animate and observe**

3. **Play with ascending node to position satellite where needed for coverage**

4. **Why did the Russians develop this type of orbit? What are the benefits?**

### 4.6 STK academic alliance program

The STK academic alliance program contract can be found in . One point that is problematic is the 5th paragraph in Section 3.0. Due to Personal Data Protection Laws, EETAC staff is not allowed to distribute students' personal data. We might ask them for authorization at the beginning of the course or hands-on activities and provide AGI only with the contact data of those students that agree. AGI assures they do not do anything with the names they capture, except maybe give them to Human Resources (HHRR) for hiring purposes.

### 4.7 General comments

In order the students to further benefit from the realization of the hands-on activities, it is worth to tell students the following considerations:

1. **Warn about the Orbit Wizard functionality**
2. **Take advantage of the 3D View/Animation mode**
3. **Better not to race but to explore when following the hands-on activity guidelines**
4. Explain the possibilities that the pull-down menus offer for viewing data related to the orbits.

5. Explain in-depth orbit perturbations:
   a. J2 harmonic perturbation
   b. Atmospheric drag
   c. Further harmonics J3 to Jn
   d. Solar gravitation
   e. Lunar gravitation
   f. Solar radiation pressure (photons and solar wind)

6. Explain in-depth the meaning of the concept of Link budget

7. It may be interesting to allocate some time at the end of the activity for the students to share with the others their answers to questions, obtained results and general comments on the activity.
Chapter 3

UTM Tests

Through the realization of this hands-on activity the students will learn the basis of the functioning and operation of a Universal Testing Machine (UTM). To achieve that objective the students will perform tensile stress (and compression stress) tests on several samples. The students will also recall the theoretical knowledge on materials’ mechanical properties that they acquired in the frame of the subject so-called Materials Science and Technology (CTM).

5.1 Preparation of the hands-on activity

- Book the respective SA-1V laboratory
- Upload in Atenea-Moodle TEA course the following documents:
  - TEA_UTM_SoW.pdf
- Students should print and read the statement of work (SoW), prior to the realization of the activity
- Print and bring copies of the SoW for the students

5.2 Activity procedure

- Here follows (Table 5.1) an example of statement of work (SoW):

  **Table 5.1 Example of statement of work.**

  The following figure shows the plot of Force [kg-f] vs. Elongation [mm] obtained through the testing of a certain metallic material with UTM in the laboratory. For obtaining the plot, a cylindrical cross section sample was tensile loaded up to breaking. The following data is provided:
  
  - initial diameter of the cross-sectional area: XX mm
  - initial length of the free sample: YYY mm (sample sections that are bitten by jaws are not considered)
  - final diameter at the breaking section after fracture: ZZZZ mm
  - final length of the free sample: TTTTT mm

  Calculate:
  
  - Young’s Modulus
  - Proportional limit
  - Yield stress (0.2% strain criterion)
  - Ductility (EL% and AR%)
  - Resilience
  - Fracture Toughness
  - Sample’s final strain and elongation at rupture point
  - Tensile stress at rupture point

---

25 This task can only be done by TEA teachers, who have editing privileges for TEA course.
26 You can see the statement of work (SoW) in section.
- Length of sample after being loaded up to Ultimate Tensile Stress (UTS) and then unloaded
- Values of plastic strain and elastic strain after this load cycle
- Hypotheses on which alloys are the samples made of

Suggestions on what the statement of work should ask the students to calculate:
- Young's Modulus
- Proportional limit
- Yield stress (0.2% strain criterion)
- Ductility (EL% and AR%)
- Resilience
- Fracture Toughness
- Sample's final strain and elongation at rupture point
- Tensile stress at rupture point
- Length of sample after being loaded up to Ultimate Tensile Stress (UTS) and then unloaded
- Values of plastic strain and elastic strain after this load cycle
- Hypotheses on which alloys are the samples made of
Wind Tunnel Tests

Through the realization of this series of hands-on activities the students will learn the basis of the functioning and operation of a Wind Tunnel (WT) and related equipment (e.g. 3-components scale for measuring lift, drag and pitching moment, hot wire anemometers, Pitot tube and static ports). To achieve these objectives, the students will perform aerodynamic tests on several models (e.g. a cylinder, a NACA0012 airfoil). The students will also recall the theoretical knowledge on aerodynamics that they acquired in the frame of the subject so-called Aerodynamics and Flight Mechanics (AMV).

6.1 PROBLEMS TO BE SOLVED

6.1.1 Problem 01: Unidentified connection tubes

The following connector tubes between the VDAS acquisition system and the NACA airfoil have to be re-identified because the number pin detached from the extreme of the tube: 4 (number pin is missing), 5, 6 (number pin is missing), 8 (number pin is missing), 12 and 20. The remaining connector tubes (1-3, 7, 9-11 and 13-19) are correctly identified and clearly marked by means of the number pin attached to the corresponding rubber tube.

Here follow some ideas to identify the connector tubes:

- Plug in the tubes one by one and check the value of the pressure in the data acquisition software. Ideally the pressure in one static port should be between the values for the previous and the following connector tube. This is a problem for connectors 4, 5 and 6, since they are successive
- Plug in the tubes one by one only. Check in which indicator in the data acquisition software the value of the pressure increases when blowing through the end of the tube with a blower or syringe. Do not blow with you mouth

6.1.2 Problem 02: Clamp is loosen

The clamp for attaching test models to the 3-components scale is loosening.

6.2 TESTS ON CYLINDER

6.2.1 Preparation of hands-on activity
6.3 TESTS ON NACA0012 AIRFOIL

This hands-on activity consists of performing tests with the NACA0012 airfoil in the wind tunnel located at Lab SA-1V. After the tests, the experimental results will be processed in order to obtain interesting information.

6.3.1 Preparation of hands-on activity

- Optional: print the SoW (to be given to students at the beginning of or during the activity)
- Study and prepare the corresponding theory about wind tunnels \(\{315\text{ Barlow, Jewel B. 1999}\}\) to be presented to students during the initial introduction to the activity
- Adjust the settings of the data acquisition software
- Make sure that the wind tunnel is ready for realization of experimental tests
- Upload in ATENEA the essential information well in advance. Here follows (Table 6.1) the message to be posted in Atenea-Moodle TEA course\(^{27}\):

<table>
<thead>
<tr>
<th>Table 6.1 Activity presentation message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind tunnel tests on a NACA0012 airfoil:</td>
</tr>
<tr>
<td>Through the realization of this series of hands-on activities the students will learn the basis of the functioning and operation of a Wind Tunnel (WT) and related equipment (e.g. 3-components scale for measuring lift, drag and pitching moment, hot wire anemometers, Pitot tube and static ports). To achieve these objectives, the students will perform aerodynamic tests on several models (e.g. a cylinder, a NACA0012 airfoil). The students will also recall the theoretical knowledge on aerodynamics that they acquired in the frame of the subject so-called Aerodynamics and Flight Mechanics (AMV).</td>
</tr>
<tr>
<td>Here you can find now the file corresponding to the draft of the Statement of Work (SoW). Each group should read and bring to class a copy of this pdf. After the realization of the activity, you will find here also the updated version of the SoW and the necessary data from the experimental tests to perform the exercises as requested in the SoW.</td>
</tr>
<tr>
<td>The deadline for delivering the solutions to the proposed exercise is the 17th of December 2009.</td>
</tr>
<tr>
<td>The following is a very interesting reference that you can find in the Campus Library:</td>
</tr>
<tr>
<td>Title: Low-speed wind tunnel testing</td>
</tr>
<tr>
<td>Authors: Barlow, Jewel B.; Rae, William H.; Pope, Alan</td>
</tr>
<tr>
<td>Source: 1999, 713, Wiley, New York, 3</td>
</tr>
</tbody>
</table>

6.3.2 Activity procedure

Here follows a series of guidelines that may help in order to conduct this hands-on activity:

- Explain what is a wind tunnel:
  - Purpose and objectives
  - Origin
  - Benefits of testing on wind tunnels: reduced costs (in comparison to flight tests), design optimization, performances prediction, etc.
- Explain the different types of wind tunnels according to several criteria:
  - Open or closed test chamber:

\(^{27}\) This task can only be done by TEA teachers, who have editing privileges for TEA course.
Advantages of closed test chamber:
- Controlled environment
- Better aerodynamics inside chamber
- Walls can support instruments

Drawbacks of closed test chamber:
- More complicated access to model

Open or closed return circuit:

Advantages of closed return circuit:
- Controlled environment (no particles, water, influence of meteorological phenomena, etc.)
- Controlled aerodynamics
- Reduction of costs for sustained long-term operation since not so much energy is wasted as in open circuit tunnels

Drawbacks of closed return circuit:
- Frictional heating of air (need for a refrigeration system)
- Need for more space and initial investment

Types are: Eiffel tunnel (open test chamber and semi-closed circuit), Prandtl tunnel (closed test chamber and closed circuit), etc.

Fluid inside the tunnel (each fluid having its particular density, and pros and cons):
- Air: small density, allows smoke, etc.
- Water: higher density of water allows aiming at increased Re, allows dye, sealing of ducts is critical, loads are larger, etc.
- etc.

Maximum achievable flow velocities:
- Hypersonic wind tunnels
- Supersonic wind tunnels
- Transonic wind tunnels
- Subsonic (low-speed and high speed) wind tunnels

Objectives of utilization:
- Space (atmospheric reentry): ultra-high Mach (hypersonic regime)
- Aeronautics: low to high Mach and Reynolds
- Civil aerodynamics: low Mach and independent of Reynolds

Explain the requirements, design constraints and problems of wind tunnels:
- Power consumption:
  \[ P = \frac{1}{2} \rho AV^2 = \frac{1}{2} \rho AV^3 \]
- Loads on structures are proportional to the square of the velocity
- Limitations in wind tunnel performances due to:
  - Power consumption (which can be very high)
  - Loads on structure and walls: involve the use of materials having good mechanical properties to ensure integrity and tunnel dimensional stability
  - Available space to allocate the tunnel
  - Blocking coefficient (ratio of frontal area of model to frontal area of test chamber) should be less than 0.1
  - Wingspan or width of model should be less the 4/5 (80%) of test chamber width {{315 Barlow, Jewel B. 1999}}

Explain the reason that justifies the validity of results obtained in a wind tunnel when testing a scale model (mock-up) {{316 White, Frank M. 2003}}:
- Validity is based on fluid mechanics Principle of Dynamic Similarity:
  If two physical phenomena can be described using the same formulation (same equations plus same initial and boundary conditions), the solutions for one of the phenomena is valid for the other one.
- In the case of air motion around and obstacle, this Principle guarantees that the non-dimensional results measured for a scale model of the obstacle in a wind.
tunnel will be the same as for the real, full-scale obstacle if the following conditions are fulfilled:

- Geometric similarity: all relevant aerodynamic features of the real obstacle must be accurately replicated in the scale model
- Mach number must be the same for the scale model and the real obstacle:
  \[ M = \frac{V}{a} \]
- Reynolds number must also be the same:
  \[ Re = \frac{\rho VL}{\mu} \]

- We assume there is no heat transfer (thermal effects) nor diffusion
  - Dilemma: If the properties of the fluid for both cases (the tests and the reality) are the same (i.e. same speed of sound, density and viscosity), it is obvious that it is not possible to have the same \( M \) and \( Re \) (given the fact that the scale model is smaller than the real obstacle):
  - Being impossible to replicate simultaneously both parameters in the wind tunnel tests, it is then necessary to choose which parameter is to be maintained constant
  - Generally, the chosen parameter should be the one that supposedly has a stronger influence on the flow (i.e. the dominant parameter). For instance, roughly speaking \( M \) is dominant for supersonic flows and \( Re \) for subsonic flows
  - In some cases, the properties of the test fluid can be tailored so it is possible to have the same \( M \) and \( Re \) for both cases (the tests and the reality)

- Explain the different parts of a wind tunnel (while showing to students the wind tunnel in the laboratory):
  - Contraction
  - Test chamber
  - Adaptation stage to power plant
  - Power plant
  - Diffuser or nozzle
  - Return circuit (guide vanes)

- Show to students how to operate the wind tunnel
- Show to students the VDAS data acquisition hardware and software and how to operate it
- Press & hold button to zero the readings of the static ports in the VDAS (note down the errors to later subtract them from the readings)
- Press & hold button to zero the readings of the 3-component scale
- Show to students the experimental data series obtained in previous tests
- Show and give to students the SoW and let them read it and think on the exercises they are requested to do
- Ask for questions or doubts regarding the previous explanations and/or the SoW

---

28 The Mach number is a non-dimensional ratio where \( V \) is the free stream velocity (velocity of an object moving through a fluid) and \( a \) is the speed of sound as it is in the corresponding fluid.
29 The Reynolds number is a non-dimensional ratio between the inertial and the viscous terms (or forces) in a fluid mechanics problem. \( L \) is a characteristic length of the obstacle.
Statement of work for Hardness Tests
HARDNESS TESTS
Statement of Work

1.- INTRODUCTION

Through the realization of this hands-on activity the students will learn the basis of the functioning and operation of a hardness tester. To achieve that objective the students will perform hardness tests on several samples.

Hardness measurements with hardness tester:

1.- The file Manual_Durometro_Metrotec.pdf is the hardness tester users guide. You don't need to read it completely. The most interesting parts for the realization of the activity are already included in the files below. Nevertheless, other important parts are those ranging from page 20 to 27 (sections 9.2. to 9.6.), 34 to 36 (sections 10.1.8. to 10.2.) and 45 to 51 (section 11.). Read them carefully.

2.- Read and bring to class a copy of pdf file:
   Pag_Manual_Durometro_Metrotec_01.pdf

3.- Read and bring to class a copy of pdf file:
   Pag_Manual_Durometro_Metrotec_02.pdf

4.- Read and bring to class a copy of pdf file:
   TEA_Hardness_tester_SoW.pdf

2.- TASKS

2.1.- Test selection

Select the most suited test for each material, according to tables in the hardness tester users guide (section 11., table 1, and section 10.1.8.):

<table>
<thead>
<tr>
<th>Material</th>
<th>Test Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fe</td>
<td></td>
</tr>
<tr>
<td>Cu</td>
<td></td>
</tr>
<tr>
<td>Al</td>
<td></td>
</tr>
<tr>
<td>Brass</td>
<td></td>
</tr>
<tr>
<td>Teflon</td>
<td></td>
</tr>
<tr>
<td>Methacrylate</td>
<td></td>
</tr>
<tr>
<td>Ceramic</td>
<td></td>
</tr>
<tr>
<td>Laminated Wood</td>
<td></td>
</tr>
</tbody>
</table>
2.2.- **Activity procedures**

- The teacher will perform 2 or 3 tests in one sample to show students how the hardness tester has to be operated (e.g. HRH test in Al samples)
- The students should split into groups (e.g. 4 groups, rocket groups)
- Each group performs one test and the sequence starts again (do as many tests as possible to improve statistical validation of results)
- It is important to remind that existing defects in the samples may cause errors in the first hardness measurements, so the first results may have to be rejected
- If possible, note down penetration depth \( h \) (or \( t \)) as it appears in the display of the hardness tester
- If possible, calculate Rockwell hardness \( HR \) with Rockwell hardness formula (see hardness tester users guide and/or other materials science and technology references [1]), where \( h \) is the input, and compare the results with the readings provided by the hardness tester
- Convert Rockwell hardness \( HR \) into Brinell hardness \( HB \) with tables: see hardness tester users guide or [2,3]:
  
  http://www.metal-mart.com/Guides/Hardness_Aluminum.htm
  
- If possible, perform a Brinell hardness \( HB \) test
- Check that the converted results are the same as those obtained through the HB test
- Calculate sample’s tensile stress \( TS \) using HB data and existing empirical formula (see materials science and technology references like [1])
- Explain reasons why hardness of annealed samples is different from the original, non-annealed samples
2.3.- **Test reports**

### Hardness Test Report

- **Test number:**

- **Test conditions and results:**

<table>
<thead>
<tr>
<th>CONCEPT</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method used</td>
<td></td>
</tr>
<tr>
<td>Preload</td>
<td></td>
</tr>
<tr>
<td>Load</td>
<td></td>
</tr>
<tr>
<td>Indentator diameter</td>
<td></td>
</tr>
<tr>
<td>Brinell Hardness HB</td>
<td></td>
</tr>
<tr>
<td>Rockwell Hardness HR</td>
<td></td>
</tr>
<tr>
<td>Vickers Hardness HV</td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td></td>
</tr>
<tr>
<td>Load time</td>
<td></td>
</tr>
</tbody>
</table>

- **Observations:**

3.- **References:**

[1] Callister, Chapter 6.10 Hardness

[2] [http://www.metal-mart.com/Guides/Hardness_Aluminum.htm](http://www.metal-mart.com/Guides/Hardness_Aluminum.htm)

Annex B

Article

Model Rocket Workshop: a Project-Based Learning experience for engineering students
Model Rocket Workshop: a Project-Based Learning experience for engineering students

JOSÉ I. ROJAS, XAVIER PRATS, ADÉLINE MONTLAUR & ENRIQUE GARCÍA-BERRO
Universitat Politècnica de Catalunya (UPC), Escola Politècnica Superior de Castelldefels (EETAC), Av. del Canal Olímpic, 15, 08860 Castelldefels, Spain

In this paper, a Project-Based Learning experience for undergraduate students of aerospace engineering is described. The experience allows the students to build a model rocket using materials which can be easily obtained. They also compute all the relevant quantities to design and characterize the rocket and they test the robustness of their design. They furthermore launch the rocket with the corresponding payload and verify the flight parameters using an on-board altimeter. Finally, they also compare the flight parameters with the theoretically expected values. Using this simple scheme the students are later introduced in the simulation of complex flows, using standard techniques. We find that our students get rapidly involved in the project, allowing them to acquire several practical abilities, besides developing an accurate knowledge of the physics of rockets and of fluid dynamics.

1. INTRODUCTION

Graduate coursework in aerospace engineering is intended in large part to prepare students for professional practice of engineering in companies and state or international agencies and, in some cases, for post-graduate research, either in the public or private sector. Accordingly, the most complete and successful graduate programs in aerospace engineering are devised to provide a solid basis in physics and mathematics. Moreover, some topics – like, for instance, aerodynamics and flight dynamics or aeroelasticity, among others – involve an accurate knowledge of the underlying physics and a considerable load of relatively complex mathematical tools. Consequently, students quite frequently become overwhelmed by the intrinsic difficulties of these topics and, also quite usually, the success rate of regular courses is small. Furthermore, in most engineering schools and for most of the relevant topics, the assessment of student performance depends largely, or even entirely, on examinations. The traditional examinations involve usually a variety of problems that are prepared to be completed in typically two hours of work in the classroom. A consequence of this way of assessing student performance is that the problems should be easy enough for the students to be able to solve them in a limited amount of time. However, in practice such simple problems do not occur in the professional exercise of aerospace engineering.

With the growth of physics education research as a research field many initiatives are currently being developed [1]. Moreover, with the ongoing desire to improve the teaching of intrinsically complex topics using reform-based approaches, there has been an opportunity to move beyond the classical structure of engineering and physics courses to new experiences in which the students are the real and leading actors of their education. Many of these experiences involve the concept of Project-Based Learning – see Refs. [2, 3, 4, 5]. In Project-Based Learning (PBL) experiences, students work in teams to explore real-world problems. In PBL experiences, students identify problems of interest to them and experiment to find solutions, as well as design complex systems that integrate engineering fundamentals in a multidisciplinary approach. Compared with conventional learning, where the students work alone and learn from textbooks or class notes, this approach has several advantages. Among these advantages a few are worth mentioning. In particular, students develop a deeper knowledge of the subject matter, increase self-direction and motivation for the particular subject, and, moreover, they attain improved research and problem-solving skills. In summary, PBL has now become a widespread teaching method in disciplines where students must learn to apply knowledge not just acquire it.

The Escola Politècnica Superior de Castelldefels (EETAC) was founded in 1991 with the clear purpose of innovating in teaching methodologies. Since then, the EETAC has achieved a solid reputation among the Spanish universities in teaching excellence. The EETAC offers two bachelor degrees in engineering. Since 1991 it has been offering a graduate degree in Electrical Engineering. This degree was initially designed taking in mind the most innovative teaching techniques at that time. For
instance, most of the graduate courses have used since then fully cooperative or PBL techniques. Student performance is done using continuous assessment. Additionally, virtual campuses and interactive learning platforms were developed from the very beginning and all courses use them. Most of these techniques or tools have been subsequently used in other engineering schools or campuses of the Universitat Politècnica de Catalunya and elsewhere. Since September 2001, a bachelor degree in Aerospace Engineering is also offered at the EETAC. When this bachelor was initially designed all the courseware (virtual campuses, assessment tools,…) where already in place. However, due to the intrinsic difficulties of some of the topics to be taught a more classical approach was originally adopted.

In this paper we present a new activity which has been proposed within the framework of a teaching unit dealing with experimental techniques in Aerospace Engineering. This subject is included in the last year of the degree and it is aimed to complement and intensify all the theoretical aspects that have been already taught during the whole bachelor degree. In this context, different and independent practical works are performed by the students within the teaching unit. In particular, the activity presented in this paper consists in designing, constructing, launching and analyzing the flight parameters of a small model rocket by using cooperative and PBL techniques. The paper is organized as follows. In section 2 we describe the course goals. In section 3 we discuss the course organization. Section 4 is devoted to describe the methodology, the managerial issues, and the material and methods needed to deliver the course. Special attention is given on how student assessment is done. In section 5 the course results are described. Finally, in section 6 we summarize our major findings and conclusions are drawn.

2. COURSE GOALS

Our objectives in designing the teaching unit were that students should learn the most relevant concepts of the problem at the appropriate deep level, become familiar with best practices research-based tools and materials, and gain insight into how engineers think about real research problems. These objectives are consistent with those of the bachelor in Aerospace Engineering program at the EETAC. We also wanted the students to practice other skills that are highly desirable in their professional field. Accordingly, during the Model Rocket Workshop the students are expected to work as they would do as engineers in a professional environment, where solutions of specific problems are formulated, planned and developed. Hence, during the workshop, some theoretical aspects related with aerospace technology (propulsion, aerodynamics and mechanics) are given but, at the same time, students are expected to develop several transversal skills such as team working, project management, leadership, problem-solving skills, oral and written communication and self-learning.

3. COURSE ORGANIZATION

At the beginning of the activity, several teams are formed depending on the number of students. Typically the teams are constituted by 4 or 5 students. The members of each group will work together in the development of a model rocket which must fulfill some specific technical requirements which are given in advance. Firstly, the flight trajectory of a generic model rocket is theoretically computed and simulated by integrating numerically the equations of motion. The students develop themselves the algorithms, the numerical tools and the corresponding software. Then, the model rocket itself is designed and constructed using simple and common materials and pieces that can be usually found for amateur or recreational uses. The simulations are updated with the final rocket real data. Before launching the models, the rocket must pass several tests with the purpose of assuring some basic safety aspects, such as rocket stability or adequate structural strength. A launch campaign is then designed and executed. The altitude versus time is recorded by means of a mini-altimeter placed inside the nose fairing of the rocket (emulating a hypothetical payload that must be safely recovered after the launch). Finally, the measured trajectory is compared with the theoretical one and conclusions are drawn and publicly presented by the members of the team to the teaching staff and students.
Statement of work for Model Rocket Workshop
MODEL ROCKET WORKSHOP
Statement of Work

1.- INTRODUCTION
Annexes

Annex D

PerfectFlite MiniAlt Users Guide
Safety Code

The Safety Code is a list of unofficial, common-sense rules in the framework of model rocketry that is internationally accepted. CSBI considers it is mandatory to obey strictly the following regulations so as to perform a safety workshop and rocket launch. For the launching of rockets within the legal frame of a country, it is worth to mention that the respective national regulations on explosives manipulation and flight of unmanned artefacts should be taken into account. These regulations are not included in this document.

- **Materials:**
  My model rocket will be made of lightweight materials such as paper, wood, rubber, and plastic suitable for the power used and the performance of my model rocket. I will not use any metal for the nose cone, body, or fins of a model rocket.

- **Engines:**
  I will use only commercially-made certified model rocket engines in the manner recommended by the manufacturer. I will not alter the model rocket engine, its parts, or its ingredients in any way.

- **Recovery:**
  I will always use a recovery system in my rocket that will return it safely to the ground so it may be flown again. I will use only flame-resistant recovery wadding if required.

- **Weight limits:**
  My model rocket will weigh no more than the engine manufacturer's recommended maximum lift-off weight for the engines used, or I will use engines recommended by the manufacturer for my model rocket. I will respect the weight limits defined by the authorities.

  *Internal Note: we do surpass willingly the maximum lift-off weight according to rocket data sheet or performances provided by the manufacturers.*

- **Stability:**
  I will check the stability of my model rocket before its first flight, except when launching a model rocket of already proven stability.

- **Payloads:**
  Except for unexpected insects, my model rocket will never carry live animals or a payload that is intended to be flammable, explosive, or harmful.

- **Launch site:**
  I will launch my model rockets outdoor in a cleared area, free of tall trees, power lines, buildings, and dry brush and grass. I will launch my model rocket from a stable
launching device that provides rigid guidance until the model rocket has reached a speed adequate to ensure a safe flight path. To prevent accidental eye injury, I will always place the launcher so that the end of the rod is above eye level or I will cap the end of the launch rod when approaching it. I will cap or disassemble my launch rod when not in use and I will never store it in an upright position. My launcher will have a jet deflector device to prevent the engine exhaust from hitting the ground directly.
Statement of Work for UTM Tests
Compendium of Procedures: TEA

UTM TESTS
Statement of Work

1.- INTRODUCTION

Through the realization of this hands-on activity the students will learn the basis of the functioning and operation of a Universal Testing Machine (UTM). To achieve that objective the students will perform tensile stress (and compression stress) tests on several samples. The students will also recall the theoretical knowledge on materials' mechanical properties that they acquired in the frame of the subject so-called Materials Science and Technology (CTM).

2.- STATEMENT OF WORK

Fig. 1 shows the plot of force [kg-f] vs. elongation [mm], obtained through the testing of a certain metallic material with the UTM in the laboratory. For obtaining the plot, a cylindrical cross section sample was tensile loaded up to breaking.

![Plot of force vs. elongation](image)

Fig. 3 Plot of force [kg-f] vs. elongation [mm]
The following data is provided:
- initial diameter of the cross-sectional area: XX mm
- initial length of the free sample: YYY mm (sample sections that are bitten by jaws are not considered)
- cross-sectional area at the breaking point after fracture: ZZZZ mm²

Calculate:
- Young’s Modulus
- Proportional limit
- Yield stress (0.2% strain criterion)
- Ductility (EL% and AR%)
- Resilience?
- Fracture Toughness
- Sample’s final strain and elongation at rupture point
- Tensile stress at rupture point
- Length of sample after being loaded up to Ultimate Tensile Stress (UTS) and then unloaded
- Values of plastic strain and elastic strain after this load cycle
- Hypotheses on which alloys are the samples made of
Annexes

Annex G

Statement of Work for Wind Tunnel Tests
WIND TUNNEL TESTS
Statement of Work

1.- INTRODUCTION

2.- DATA

Laboratory test ambient conditions: atmospheric temperature, pressure and air density (see Table 2).

<table>
<thead>
<tr>
<th>Calculated Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Temperature (°C)</td>
</tr>
<tr>
<td>20.0</td>
</tr>
</tbody>
</table>

**Table 2** Plot of frequency [Hz] vs. flow velocity [m/s] inside test chamber.

Flow velocity inside the test chamber has been experimentally determined to be quasi-linear with frequency (see Table 3).

<table>
<thead>
<tr>
<th>Freqüência (Hz)</th>
<th>Velocitat (m/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>7.44</td>
</tr>
<tr>
<td>20</td>
<td>15.30</td>
</tr>
<tr>
<td>30</td>
<td>22.63</td>
</tr>
<tr>
<td>40</td>
<td>29.99</td>
</tr>
<tr>
<td>50</td>
<td>36.31</td>
</tr>
</tbody>
</table>

**Table 3** Frequency [Hz] vs. flow velocity [m/s] inside test chamber.
NACA0012 airfoil characteristics (see Table 4): airfoil wingspan, chord, mass and x-coordinate of static ports in upper and lower surface.

<table>
<thead>
<tr>
<th>Punts</th>
<th>Coordenada x</th>
<th>Punts</th>
<th>Coordenada x</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extrados</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.76</td>
<td>2</td>
<td>1.52</td>
</tr>
<tr>
<td>3</td>
<td>3.81</td>
<td>4</td>
<td>7.62</td>
</tr>
<tr>
<td>5</td>
<td>11.43</td>
<td>6</td>
<td>15.24</td>
</tr>
<tr>
<td>7</td>
<td>19.05</td>
<td>8</td>
<td>22.86</td>
</tr>
<tr>
<td>9</td>
<td>38</td>
<td>10</td>
<td>41.15</td>
</tr>
<tr>
<td>11</td>
<td>62</td>
<td>12</td>
<td>59.44</td>
</tr>
<tr>
<td>13</td>
<td>80.77</td>
<td>14</td>
<td>77.73</td>
</tr>
<tr>
<td>15</td>
<td>101.35</td>
<td>16</td>
<td>96.02</td>
</tr>
<tr>
<td>17</td>
<td>121.92</td>
<td>18</td>
<td>114.3</td>
</tr>
<tr>
<td>19</td>
<td>137.16</td>
<td>20</td>
<td>129.54</td>
</tr>
<tr>
<td>Final</td>
<td>150</td>
<td>Final</td>
<td>150</td>
</tr>
</tbody>
</table>

**Table 4** NACA0012 airfoil characteristics.

2. Results:

The results are summarized in the HTML file: Prac_TV_07-10-24_Data, also uploaded in ATENEA-Moodle.

In the file you will find 2 series of results: ‘Data Series 1’ and ‘Data Series 2’:

**Data Series 1:** Measurements at 20Hz:
- 1st row: angle of attack (AOA) 0°
- 2nd row: AOA 5°
- 3rd row: AOA 10°

**Data Series 2:** Measurements at 30Hz:
- 1st row: AOA 0°
- 2nd row: AOA 5°
- 3rd row: AOA 10°
3.- Exercises:

For each velocity and each AOA:

3.1.- Calculate the pressure coefficient for upper and lower surfaces:

\[ C_p(x) = \frac{p(x) - p_\infty}{\frac{1}{2} \rho V_\infty^2} \]

3.2.- Calculate the lift coefficient distribution:

\[ C_l(x) = C_{p_l}(x) - C_{p_E}(x) \]

3.3.- Calculate the airfoil’s lift coefficient (being LE and TE the x-coordinate of the leading edge and the trailing edge, respectively):

\[ C_l = \frac{1}{c} \int_{LE}^{TE} C_l(x) dx \]

Which is the trend of the lift coefficient as the AOA increases?
Does the wind velocity increase affect the lift coefficient for each AOA?

3.4.- Calculate the airfoil’s pitching moment coefficient, respect to the leading edge LE:

\[ C_{m,LE} = -\frac{1}{c^2} \int_{LE}^{TE} C_l(x) dx \]

Which is the trend that follows the pitching moment coefficient as the AOA increases?
Does the wind velocity increase affect the pitching moment coefficient for each AOA?

3.5.- Calculate the position of the pressure centre of the airfoil (cp). Where is the pressure centre shifted towards as the AOA increases?

3.6.- Calculate the airfoil’s pitching moment coefficient, respect to the aerodynamic centre (ca supposed at x=c/4):

\[ C_{m,ca} = -\frac{1}{c^2} \int_{LE}^{TE} C_l(x)(x - \frac{c}{4}) dx \]

Is it bigger or smaller than the pitching moment coefficient respect to the leading edge LE?

3.7.- Calculate the lift generated by a 2D airfoil:

\[ l = \frac{1}{2} \rho V^2 c C_l \]

3.8.- Calculate the lift generated by the whole wing, supposing the lift coefficient for the wing and for a 2D airfoil is the same:

\[ L = \int_{-b/2}^{b/2} \frac{1}{2} \rho V^2 c C_l dy = \frac{1}{2} \rho V^2 S C_L \]
IMPORTANT: You should check if the experimental results agree with the theory. So check for instance: 1) whether the lift coefficient of the airfoil increases linearly as the AOA increases, and 2) whether the free stream velocity affects the lift coefficient for a given value of AOA. You should bear in mind that we took just one set of measurements for each pair velocity-AOA. For improved statistical validity, we should have taken many more sets of measurements for each pair velocity-AOA, and base the calculations in the averages. So instrument errors can probably cause experimental results not to agree with what expected according to theory.